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1  

Introducing Scorbase 

Scorbase for ER 9Pro/ER 14Pro is a robotics control software package for 

robot programming and operation. Scorbase for ER 9Pro/ER 14Pro provides 

numerous capabilities: 

 Communication with the robot controller over USB channel. 

 Control and real-time status display of robot, gripper and peripherals. 

 Full support and real-time status display of 16 digital inputs, 16 digital 

outputs, four analog inputs, and two analog outputs. 

 Position definition and display as well as manual robot movement in 

reference to Joint Coordinate System (encoder units).  

 The Cartesian Coordinate System (X,Y,Z, Pitch and Roll) is also used. 

 Robot movement definition as  

 Go to Position,  

 Go Linear, or 

 Go Circular, with 1~100 (percent) active speed settings, and the option 

of defining the movement duration in 1/10s. (Availability depends on 

Experience Level setting.) 

 Scorbase program run time position manipulation. 

 Default setting of 5000 positions. 

 Interrupt programming for handling responses to changes in digital input 

status. 

 Variable Programming, in three levels of complexity, to moderate the 

learning curve. This makes it possible for beginners to start at a lower 

level, and advance through the levels, as they become more skilled in 

robotics programming. 

 Visual Basic Script language integration to realize user-defined algorithms 

with floating point numbers, read/write to file, integration with Excel and 

using the other Windows operating system facilities. 
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 Saving and loading projects. 

 Scorbase can be installed as part of Robocell, an interactive graphic 

software package, which provides simulation of the robot and other 

devices in the workcell. (Scorbase is necessary for the operation of the 

Teach Pendant.) 

 Multitasking capability with 100 concurrent running programs. 

This manual describes all the features and operations for all Experience Levels 

of Scorbase. When necessary, illustrations show the differences in the levels, 

and descriptions note the availability of options and commands.
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2  

Starting Scorbase 

The instructions in this chapter are for Scorbase only.  

If you intend to install Scorbase as part of the Robocell software package, 

follow the instructions in Chapter 2, Starting Robocell, in the Robocell User 

Manual. 
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System Requirements 

For best performance, the following system is recommended: 

 Intel Core i5 2400 GHz 2400 GHz or higher, equipped with CD drive 

 At least 4 GB RAM or higher 

 A hard drive with at least 200 MB of free disk space 

 A mouse  

 USB port 

 Windows 7 Home Premium and above, or Windows 8/8.1 Core and above, 

or Windows 10 Pro and above 

Note: Your operating system might have additional hardware requirements. 
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Installing the Software 

The Scorbase software is supplied on a CD which also contains Robocell. 

Close any open applications before proceeding with the installation procedures. 

If you are about to reinstall the software, or install a newer version to an 

existing Scorbase directory, it is recommended that you back up any existing 

user-created files before you begin the installation. It is also recommended that 

you remove the previous Scorbase version using the Uninstall utility. Select the 

Uninstall menu item from the Start | Programs | Scorbase-Pro menu group.  

To install Scorbase: 

1. Insert the CD into the CD/DVD drive. The installation should begin 

automatically. If it does not, run RobocellProSetup.exe from the CD 

\Install folder. 

 

Wait until the Welcome window is displayed. 

 

Figure ‎2-1: Welcome Window 
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2. Click Next to open the License Agreement Window.  

 

Figure ‎2-2: License Agreement Window 

3. Review the Intelitek software license agreement. You must accept the 

terms of this agreement in order to proceed with the installation. To 

accept, press Yes. The Setup Type window is displayed. 

 

Figure ‎2-3: Software Selection Window 
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4. Select Scorbase for ER 9Pro, Scorbase for SCORA-ER 14Pro, 

Scorbase-PRO for Mobile Robot or Robocell for SCORBOT ER 

9Pro. The robot that you select becomes the default robot while you 

are working in Scorbase, although you can choose to open a new 

project and work with a different robot. See the Hardware Setup 

option in the Options Menu. 

5. Click Next to open the Choose Destination Location Window. 

 

Figure ‎2-4: Choose Destination Location Window 

The default destination folder for the files is: 

\ Intelitek\Scorbase-PRO 

6. Click Next to accept the default, or click Browse to select another 

folder and then click Next to open the Select Program Folder 

window.  



SCORBASE  2-6 User Manual 

Starting Scorbase  200030, Rev. D 

 

Figure ‎2-5: Select Program Folder Window 

In the Select Program Folder window you are requested to select the 

folder to which the program icons will be added.  

7. Click Next to complete the installation procedure. 
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Uninstalling the Software 

To uninstall Scorbase: 

1. From the Scorbase-PRO or Robocell-PRO program group, select 

Uninstall. 
2. Follow the instructions which appear on the screen. 
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Starting Scorbase 

To start Scorbase: 

1. Make sure that all the components to be used are installed and 

connected according to the installation procedures detailed in the 

User Manuals supplied with the robot and controller. 

2. Turn on the computer and the controller. 

3. Select Start | Programs | Scorbase-Pro. 

4. Select the Scorbase-Pro command. After initialization, the 

following screen appears:  

 

Figure ‎2-6: Scorbase Opening Screen 

If Scorbase opens in Off-line mode or the controller is not detected, the 

program will load and operate in Off-line mode.  

By default, only one instance of Scorbase can be active at a time. 
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Using the robot with the Controller 

To start using the robot with the Controller: 

1. Turn the Controller on by pressing the switch. 

2. Change to On-line by selecting Options | On-line. 

3. Enable control of the axes; do one of the following: 

 Select Options | Control On. 

 Click the Control On icon. 

 Press the F5 key. 

4. Start the homing procedure by doing one of the following:  

 Select Run | Search home - all axes. 

 Click the Search Home  icon. 

Scorbase can now run user-defined or existing demo programs into the  

Projects\<robot type> directory. 
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Quitting the Software 

Stop the Scorbase program (if running). If you have unsaved changes in the 

project, Scorbase prompts you to save the changes before closing. 

To close Scorbase (or its components), do any of the following: 

 From the Menu Bar, select File | Exit. 

 Click the Close box in the Scorbase Title Bar. 

 Press [Alt]+F4. 

If changes to a program or position file have been made but not yet saved, a 

message appears giving you the opportunity to save the file before you exit 

Scorbase. 
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Menus Overview 
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The Scorbase Window 

Figure 3-1 shows the Scorbase opening screen which comprises: 

 A Title Bar containing the screen name and the usual Windows controls 

for sizing and closing the application screen.    

 A Menu Bar containing all Scorbase command menus and options. 

 A Toolbar containing icons for the most commonly used options.  

 A Status Bar displaying information regarding the Scorbase software, 

modes of operation, current activity, etc. When you position the mouse 

over an icon, a description of the icon appears in the status bar. 

Note: The System menu (displayed by right clicking the Title Bar) contains the 

Always on Top menu item, enabling you to display the application on top at all 

times. 

 

Figure ‎3-1: Scorbase Window 
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File Menu 

A Scorbase project contains a program (SBP file), user-defined positions (PNT 

file), and a project data file (WS file). If Robocell is also being used, the project 

includes the cell image (3DC file). Throughout this manual, the term “project” 

refers to the program positions (and image) files saved by the user as one 

entity. 

 

 

The File menu contains the usual Windows functions that allow you to open 

new or previously saved projects, save and close projects. You can print 

files containing robot programs and positions, and exit the software. 

 

 

 

 

 

 

The File menu options are: 

 

New Project 
(Ctrl+N) 

Opens a new, untitled, project named Untitled. All 

project-related files are created. 

 

Open Project 
(Ctrl+O) 

 

Opens a Load Project File dialog box for opening a 

previously saved project. All project-related files are 

opened.  Only one project may be open at a time. 

 

Save Project 
(Ctrl+S) 

Saves the currently active project. If the project has not 

previously been saved (i.e., is untitled), a dialog box for 

specifying the project name opens.  

All project-related files are saved, including Program, 

Positions and Graphics. 

 Save Project As... Opens the Save Project dialog box for saving the 

currently active project under a new name.  

All project-related files are saved under that new name. 

As default, all projects are saved in a Projects folder. 

 Close Project Closes the currently open project. 

 

 New Script By default, opens Notepad. The user can then begin to 

write a new Visual Basic script file. 
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 Open Script Opens File Selector box for opening an existing 

Visual Basic script file. 

 Print Program Prints the program. (Program window must be active). 

 Print Positions Prints the position table. 

The Position window must be open and active to 

select this option. You can open the Position window 

by selecting View | Positions. 

 Print 3D Image Prints the 3D image (if Robocell program is installed). 

 Print Preview  
3D Image 

Opens a dialog window that shows how the printed 

cell will appear on paper (if Robocell program is 

installed). 

 Print Charts Opens a dialog box to select the specific axis chart for 

display or printout. Only one axis can be selected at a 

time.  

 Print Preview 
Charts 

Opens a screen, which displays the selected axis chart 

before printout showing how the printed cell will 

appear on paper. 

 Import 3D Model Opens the Import 3D Image dialog window showing 

the graphic module files (*.3DC files) (if Robocell 

program is installed). 

 Edit 3D Model Opens the Graphic Module in CellSetup (if Robocell 

program is installed). 

 View File Enables you to view a file from those listed: 

 Graphic module files (*.3DC) 

 Scorbase programs (*.sbp) 

 Position data (*.pnt) 

When you select a file, a window opens displaying 

that file. 

After opening a Scorbase program for viewing, you 

may select and copy (CTRL+C) a code snippet and 

paste it into a writing program. 

 Exit Closes Scorbase. If changes to a program or position 

file have been made but not yet saved, a message 

appears giving you the opportunity to save the file 

before you exit Scorbase. 
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Edit Menu 

 

The Edit menu contains the usual Windows functions that allow you 

to edit program files. See the Program Editing Tools section on page 

6-5. 

Cut (Ctrl+X) 

 

Deletes selected text or lines from the 

program lines, and places it on the Windows 

and Scorbase clipboards.  

Copy (Ctrl+C) 

 

Places a copy of selected text or lines from 

the program lines on the Windows and 

Scorbase clipboards.  

 Paste (Ctrl+V) 

 

Inserts the contents of the Scorbase clipboard 

into the program lines.  

 Find (Ctrl+F) 

 

Opens a dialog box that allows you to search 

for a particular text string, Scorbase 

command, or command argument.  

 Find Next Repeats the last Find operation for the next 

occurrence.  

 Command/Remark 

(*…) (Ctrl+R) 

 

Inserts/deletes asterisk at beginning of a 

Scorbase program command line. This action 

toggles the command line between a remark 

and an executable command.  

 Go to Line Opens a dialog box that displays the total 

number of lines in the program, and prompts 

you for a line number. The program editor 

jumps to the line you specify.  

 Go to Selected 
Line 

Display the line selected. Useful for long 

programs.  
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Run Menu 

 

 

The Run menu contains Scorbase commands for homing the robot and 

peripheral axes (see Chapter 4: Homing and Control), and executing 

programs. 

 

Note: If the software is operating Off-line, only the Run program options are 
available in this menu. 

 

Search Home - 
All Axes 

Homes both the robot and any configured 

peripheral axes. See the Homing section on 

page 4-4. 

 Search Home – 
Robot 

Homes the robot. 

This command is available only if the system 

has been homed once, after opening Scorbase. 

See the Homing section on page 4-4. 

 Search Home – 
Peripherals  

Homes the peripheral. 

This command is available only if the system 

has been homed once, after opening Scorbase. 

See the Homing section on page 4-4. 

 Go Home – All 
Axes 

Sends the robot and peripherals to their home 

positions. See the Homing section on page 4-4. 

 Go Home - 
Robot 

Sends the robot to its home position. This 

command does not home the robot. See the 

Homing section on page 4-4. 

 Go Home – 
Peripherals 

Sends the peripherals to their home position. 

This command does not home the peripherals. 

See the Homing section on page 4-4. 

 

Run Single Line 

(F6) 

Executes the selected (highlighted) program 

line. See the Program Execution section on page 

8-1. 

 

Run Single 
Cycle (F7) 

Executes the program from the selected 

(highlighted) program line to the end of the 

program. See the Program Execution section on 

page 8-1. 
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Run 
Continuously (F8) 

Executes the program from the selected 

(highlighted) program line. When the last 

program line is reached, the program starts 

again from the first line. See the Program 

Execution section on page 8-1. 

 

Stop (F9) Immediately stops program execution and 

movement of all axes.  See the Program 

Execution section on page 8-1. 

 

Pause (F10) Stops program execution after the current line is 

executed. See the Program Execution section on 

page 8-1. 

 Note: Pause and Stop are software methods for halting program 

execution. In an actual emergency situation, you should use the 

EMERGENCY button on the controller, the EMERGENCY button 

on the Teach Pendant, or an external EMERGENCY button 

(optional). 
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Options Menu 

 

 

The Options menu allows you to define your preferences for operating 

the software.  

 

 

 

On-Line Establishes communication with the controller. See 

the On-Line Mode / Off-Line Mode section on page 

4-7. 

Off-Line Scorbase does not communicate with the controller, 

even though it may be connected.  

Off-line mode is useful for checking and debugging 

programs. See the On-Line Mode / Off-Line Mode 

section on page 4-7. 

 

Control On 

(F5) 

Enables servo control of the axes. See the Control On 

/ Control Off – CON/COFF section on page 4-8. 

 

Control Off Disables servo control of the axes. See the Control On 

/ Control Off – CON/COFF section on page 4-8. 

 

 

 Hardware 
Setup 

Opens the Hardware Setup dialog box. See the Hardware Setup section 

on page 10-9. 

 

Figure ‎3-2: Hardware Setup Dialog Box 

You can define which robot to control, the gripper type, and the 

peripheral devices which are connected and operated by the controller. 
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 Set 
Parameters 

Opens the Parameter Set Window (see Figure ‎10-15 and Figure ‎10-16). 

You have to activate Advanced Commands before can you utilize Set 
Parameters. See Advanced Options below 

 

Figure ‎3-3: Parameter Set Window 

Parameters can be set for the robot and for each one of the eight axes. 

Select the appropriate tab and set the desired parameters. 

Note: For safety reasons, certain parameters are not accessible by the 

user and they appear grayed. They can be changed only by Intelitek 

support personnel. 

 Maintenance Displays option to open the Homing Diagnostic Window. 

 Line Number Shows/hides program line numbers in the program window. 

 Reload Last 
Project at 
Startup 

When checked, opens the last project saved when Scorbase is started. 

 

Level 1 Displays list of commands and options at introductory level. 

Commands related to Level 2 and Pro are disabled.  See the Experience 

Level section on page 10-17. 

 

Level 2 Displays list of commands and options at advanced level. Commands 

related to Pro are disabled. See the Experience Level section on page 

10-17. 

 

Pro Displays list of all commands and options. See the Experience Level 

section on page 10-17. 
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 Advanced 
Options 

Opens a dialog box in which these options are available: 

 Advanced Commands (See the ‎0Program Editing section on page 6-

1). 

 ViewFlex Commands (see the ViewFlex User Manual). 

 

Figure ‎3-4: Advanced Options Dialog Box 

When one or both options are checked, the corresponding commands 

(Advanced Commands and Vision Commands) are listed under the 

Command tab of the Workspace Window. 

When Advanced Commands is selected, a warning appears. Click OK 

to accept responsibility for activating advanced options.  

 
Figure ‎3-5: Advanced Commands Warning 
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View Menu  

The options in the View menu allow you to show/hide Scorbase dialog 

bars and windows. 

 

 

 

 

 

 

 

Workspace Shows/hides the Workspace Window. Through this 

window, the user can access the project files and the 

Scorbase commands tree. See the Program Editing 

section on page 6-1. 

Manual 
Movement 

Shows/hides the Manual Movement Dialog Box. This 

box enables manual control over the movements of the 

robot, the gripper and peripheral axes. 

Teach 
Positions 

Shows/hides the Teach Positions Dialog Box. This 

box enables recording, teaching and deleting 

positions. It also enables the user to send the robot 

and/or peripherals to a previously defined position. 

The functions available depend on the current 

Experience Level setting. 

Robot 
Movements 

Opens the Robot Movement Dialog Box. Pressing on 

a selected axis moves it in the selected direction. 

Positions The Positions Window displays the positions of the 

currently open project. The list is presented in tabular 

format. 

Charts Opens Charts. 
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Dialog Bars Toggles the display of seven dialog bars that enable 

the following: 

 Joints – Displays the robot’s joints angle. 

 XYZ - Displays the robot tool center point (TCP) 

position and orientation. The coordinate system 

origin is at the center of the robot base at table 

level. 

 Digital outputs - Displays the status of digital 

outputs 1-16 (dark green - off; light green - on).  

Click on an output to show/hide its status. 

 Digital inputs - Displays the status of digital 

inputs 1-16 (dark green - off; light green - on).  In 

Off-line clicking on input toggles its status. 

 Analog outputs - Displays the value of analog 

output 1&2 (0-255)-(0-10 volt). 

 Analog inputs - Displays the value of analog input 

1-4 (0-255). In Off-line you may set the analog 

input value. 

 Encoders – Displays the encoder counts of axes 1-

8. (Encoders are zeroed after homing the system.) 

 See the Position Data Dialog Bars section on 

page5-21 and the Inputs and Outputs Dialog Bars 

section on page 8-5. 

Show All 
Dialog Bars 

Displays all seven dialog bars. 

Close All 
Dialog Bars 

Closes all seven dialog bars 

Movement 
Information 

Displays the following data: 

 Position error of eight axes in encoder counts 

 Home switch status of all eight axes 

 Index pulse status of all eight axes 

PWM for one selected axis. The PWM (Pulse Width 

Modulation) is the controller output for the selected 

axis motor. 

Messages Opens the Messages Window. 

The data displayed in the Messages window is printed 

using the PS (Print to Screen & Log) commanding 

Scorbase. 

Toolbar Shows/hides the programming toolbar (default on). 

Status Bar Shows/hides the lower status bar (default on). 
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Window Menu 

 

The Window menu enables you to select the desired window layout 

options.  

Simulation & 
Teach 

Sets the screen to display the Robocell window 

and dialog bars required to define positions.  

This is disabled in Scorbase. 

Teach & Edit Opens Program Window, Workspace Window, 

Manual Movement Window and Teach Position 

Window. 

Run Screen Displays the Program Window, together with 

its toolbar. 

Project Screen Displays the Program Window and Positions 

Window. 

Open CIM Screen Displays Program Window, Open CIM Device 

Driver Window, and CIM Messages Window. 

User Screen This allows the user to customize the screen 

layout according to personal preference. 

Save User Screen This saves the User Screen layout for later 

recall with the User Screen command. 

[Project Name] Displays the file name of the open project. 
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Help Menu 

 

The Help menu options:  

 

Scorbase Help 
(F1)  

Opens Scorbase on-line help. 

Scripting Help Opens help files for Visual Basic scripting. 

About Shows the Scorbase software version and the 

Controller USB-Pro embedded software 

version when Scorbase in On-line mode.  
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Charts 

Scorbase charts can be configured to display the following data (Y-axis) vs. 

time (X-axis). 

 Encoder counts (axis position), represent the actual axis position. The 

encoder counts are shown in a blue line. 

 Position error is the difference between the required axis position and the 

actual axis position. The error is expressed in encoder counts and shown in 

a red line. 

 The PWM value represents the controller output. The error and the axis 

control parameters determine the PWM value shown in a green line. 

The data for each axis (1-8) is shown in a different chart. Sample charts for 

axes 1 and 2 are shown in Figure ‎3-6. 

 

Figure ‎3-6: Chart for Two Axes 

To open the Charts window, do one of the following: 

 Click the Charts icon in the toolbar . 

 Select View | Charts. 

The following options are available in the Charts window toolbar: 

 

Start chart Starts drawing the chart. 

 
Stop chart Stops drawing the chart. 
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Options Opens the Chart Options dialog box where you can select 

the data to be displayed in the chart(s).  

 

Figure ‎3-7: Chart Options Dialog Box 

Click the data that you want displayed in the charts.  

The example shown in Figure ‎3-7 results in the display of 

the Encoder, Error and PWM of axis 1, as well as the 

display of the Encoder and Error for axes 2 through 6. 

Since each axis is shown in a different chart, six charts will 

be displayed. 

Any chart can be saved to a history (*.his) file. To do so: 

 Check the Record History box. 

 Click the Browse button (which becomes available) to 

open the window.  

 Select the folder and enter the name of the file to be 

saved. 
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Figure ‎3-8: Open Project Dialog Box 

To set the resolution of the chart for the Encoder, Errors 

and PWM: 

 Click the Advanced button in the Chart Options dialog 

box. The Range column opens. 

 

Figure ‎3-9: Chart Options Dialog Box 

 

 

History Opens the History Files Window. Select the desired history 

(*.his) file from the list or browse to locate it.  
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Figure ‎3-10: History Files Window 

Note: To open a history file you must first stop drawing the 

chart. 

 

Legend Displays the colors used in the charts for Encoder, Error 

and PWM. 

Encoders – Blue 

Error – Red 

PWM – Green 
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4  

Homing and Control 
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General 

The robot and peripheral axes location is monitored and controlled using 

incremental encoders.  

Scorbase offers two commands relating to the home position. 

 Search Home is the procedure for homing. During Search Home, each 

axis is homed separately. The controller initializes the axis encoder counter 

and turns to home the next axis. After all configured axes are homed, the 

homing procedure ends. 

 Go Home sends the selected axes to Home position. Note: This command 

does not home the axes. 

The two commands are available in three levels: 

 Search / Go home all (applies for all active axes) 

 Search / Go home robot (applies for the robot) 

 Search / Go home peripherals 
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Homing 

Search Home All Axes 

The Search Home - All Axes command executes the robot’s homing 

procedure as well as that of any peripheral devices that have been configured in 

the Options | Hardware Setup menu.  

After turning the Controller on, Homing must be performed. 

To start the homing procedure, do one of the following: 

 Select Run | Search home - all axes. 

 Click the Search Home  icon. 

A window opens displaying the number of the axis currently being homed. 

Each time an axis is successfully homed, a checkmark appears next to the axis 

number. After the five axes and the gripper have been homed, a checkmark 

appears next to Robot. 

 

Figure ‎4-1: Homing Status Window 

To abort homing while the procedure is still in progress, do one of the 

following: 

 Press [F9] (Stop command)  

 Press the red EMERGENCY button on the controller. 

 Press the EMERGENCY button on the Teach Pendant. 

If the homing procedure fails, a message appears. 

If the system has already been homed and you change Scorbase to Off-line 

mode, there is no need to home the system again when you return to On-line 

mode. 
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When Scorbase is in Off-Line Mode, or Simulation Mode, the homing 

procedure is not required, although it can be executed. The homing procedure 

initializes Joint and XYZ values according to a software definition. All 

encoders are set to 0, while the robot Cartesian coordinates are set according to 

a software model. 

Search Home - Robot 

This command runs the homing procedure for the robot. Homing of the robot is 

enabled only after the system has been homed once.  

Search Home - Peripherals 

This command runs the homing procedure for the configured peripherals. 

Homing of the peripherals is enabled only after the system has been homed 

once.  
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Go Home Command 

Go Home All Axes – Robot – Peripherals 

After the axes have been homed, you may select Run | Go Home - All Axes 

to send the axes back to their home position at any time. This command sends 

the robot and peripherals to a position where the axes encoders value equals 

zero. The Go Home command does not run the homing procedure. 

Selecting the Go Home - Robot or Go Home - Peripherals command sends 

the selected axis to its home position. 
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On-Line Mode / Off-Line Mode 

Scorbase can run either in On-line or in Off-line mode. In On-line mode, 

Scorbase communicates with the controller over the USB channel. If the 

Control On state is selected, Scorbase controls the robot, peripherals and I/O 

device. In Off-line mode, Scorbase can be used for programming and 

debugging. The active mode is displayed in the status bar. 

To change to On-line, select Options | On-line. 

To change to Off-line, select Options | Off-line. 

If Scorbase is opened in On-line, or On-line is selected from the Options menu, 

this message appears as Scorbase searches for the controller: 

 

Figure ‎4-2: Controller Search Status Window 

If the controller is detected, On-line mode is activated. 

If the controller is not detected, Off-line remains the active mode. 
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Control On / Control Off – CON/COFF 

The Control On state enables servo control of the axes. This state is available 

only in On-line mode. In the Control Off state, axis movement commands 

cannot be executed. The Control state (On or Off) is displayed in the lower 

right corner of the status bar. 

To enable control of the axes, do one of the following: 

 Select Options | Control On. 

 Click the Control On icon. 

 Press the F5 key. 

To disable control, do one of the following: 

 Select Options | Control Off. 

 Click the Control Off icon. 

If you have disabled control and Scorbase opens in On-line mode, or On-line 

mode is selected after detection of the controller, this prompt appears: 

 

Figure ‎4-3: Control On Confirmation Dialog Box 

Press OK to enable control or press Cancel to remain in the Control Off state. 

The controller automatically disables control if an impact condition, trajectory 

error or thermic overload error occurs during execution of a movement 

command. If you attempt to move the axes when control is disabled, this error 

message appears: 

 

Figure ‎4-4: Axis Move Error 

When Scorbase is in Off-line mode, the Control On/Off state cannot be altered. 

 



User Manual  5-1 SCORBASE 

200030, Rev. D  Position Definition 

5  

Position Definition 

Every Scorbase project includes a set of pre-defined positions and a program 

that sends the robot from one position to the other. Prior to running a program 

all the positions used in that program should be defined. Scorbase offers 

various tools to define and store positions that will be used in the programs.  

The following Scorbase tools are used in the position definition process. 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Robot Movement Dialog Box 

 Position Data Dialog Bars 

 Positions Window 

To activate the dialog boxes which are most useful for position definition, 

select Window | Teach & Edit. 

Any of the following four methods can be used for position definition:  

No. Method Level 

1 Absolute position Joint coordinates 1, 2, Pro 

2 Relative position Joint coordinates 2, Pro 

3 Absolute position Cartesian coordinates 2, Pro 

4 Relative position Cartesian coordinates 2, Pro 

 

Note: Peripheral position definition can only be performed in the Pro level.  
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Joint and Cartesian Coordinate 
Systems 

Defining a position in Scorbase can be done by using either the Joint or 

Cartesian coordinate systems. 

 An encoder is an angular movement sensor attached to the axes motor. 

A Peripheral position is always defined using one variable that stores the sensor 

output (encoder value) of that position.  

Joint Coordinate System 

A robot position in Joint coordinates is defined by five angle values for the ER 

9Pro robot, representing each angle of the joints. The joint names are Base, 

Body, Upper Arm, Forearm, and Flange.  

 

Figure ‎5-1: ER 9Pro Robot Joints 

For example, after homing, the robot position in Joints coordinates is: 

Axis #1 - Base = (0) 

Axis #2 - Shoulder = (-90.73) 

Axis #3 - Elbow = (11.65) 

Axis #4 - Pitch = (68.01) 

Axis #5 - Roll = (0) 
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Cartesian Coordinate System (XYZ) 

A robot position in Cartesian (or XYZ) coordinates is defined by these 

parameters.   

 The distance of the robot’s Tool Center Point (TCP) from the point of 

origin (the center bottom of the robot base), along the three axes that 

describe three-dimensional space (X,Y,Z). 

 The Pitch (P) and Roll (R) angles of the gripper, specified in angular units. 

 

Figure ‎5-2: Joint and Cartesian (XYZ) Coordinates 

For example, after homing, the robot position in Cartesian coordinates is 

defined as: 

X = (219.87) [mm] 

Y = (-42) [mm] 

Z = (917.34) [mm] 

Pitch = (11.08) 

Roll = (0) 

A position recorded in one coordinate system can be converted by Scorbase to 

another coordinate system. 
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For advanced users only: 

For more precise robot positions in Cartesian coordinates you may change the 

encoder count offset from the robot homing position can be defined using the 

Calibration cartesian coordinate parameters dialog box. 

To calibrate the Cartesian coordinate parameters: 

1. Ensure that robot is homed. 

2. Press the Ctrl + Alt + C keys simultaneously. The Calibration 

cartesian coordinate parameters dialog box is displayed. 

3.  
4. Using either the Manual Movement Dialog Box or the Teach 

Pendant, move axes 2, 3, 4 and 5 to a totally horizontal position with 

Scorbot ER-9PRO. Use a leveler to confirm that they are totally 

horizontal. 

5. In the Calibration Cartesian coordinate parameters dialog box click 

Get Actual Encoders. Click Apply to calibrate the new parameters.  

Default parameters can be restored by clicking Get Default Encoders and 

Apply buttons in the Calibration Cartesian coordinate parameters dialog box. 
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Absolute and Relative Positions 

Scorbase offers two methods of defining a robot or peripheral position: 

Absolute and Relative. The two methods are applicable in Cartesian and in 

Joint coordinates.  

An absolute position is defined using all five robot position parameters. If the 

Joint coordinate system is used, the robot position is defined using the Base, 

Shoulder, Elbow, Pitch, and Roll angles. In the XYZ coordinate system, a 

position is defined using the X, Y, Z values in millimeters, and the Pitch and 

Roll angles in degrees. An absolute position is usually a fixed position in world 

space. 

A relative position is a position whose coordinates are defined as an offset 

from a reference position coordinates. If the coordinates of the reference 

position change, the relative position moves along with it, maintaining the 

same offset. A relative position can be defined in either Cartesian or Joint 

coordinate values. 

A position can also be defined as relative to current. In this case, the relative 

position is calculated as an offset from the coordinates of the current robot 

position. 
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Record and Teach 

Although the terms teach and record are often used interchangeably, Scorbase 

makes the following distinction: 

Record position: defines a robot position in a Joint coordinates system.  

Teach position: defines a robot position in a Cartesian coordinates system. The 

user must define the coordinates. 
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Manual Movement Dialog Box 

Recording a robot position (in Joint coordinates) is done by manipulating the 

robot to the required position and then recording it. The Manual Movement 

dialog box allows direct control and manipulation of the robot and peripheral 

axes. 

The Manual Movement dialog box is automatically opened when a project is 

opened, or when the Window | Teach & Edit display setting is selected. 

To open the Manual Movement dialog box when there is no open project, 

select View | Manual Movement.  

 

 

Figure ‎5-3: Manual Movement Dialog Box (Joints) 

Note: Axis 6 is not applicable for a pneumatic gripper.  Peripheral axes are 

only applicable when defined using the Options | Hardware Setup dialog 

box. 

Note: When a SCORA-ER 14Pro is connected and configured using the 

Options | Hardware Setup dialog box, only the four axes that it has will be 

available for use, as well as the peripheral axes that are configured as above. 

 

The following chart explains how clicking the buttons in the Manual 

Movement dialog box (or pressing the corresponding keys on the keyboard) 

controls the robot and peripheral movements. 

Joints When Joints is selected, clicking the buttons (or pressing 

the corresponding keys on the keyboard) moves one 

robot axis at a time, as described below: 

 Keys Joint Motion 

 1 / Q Rotates the BASE right and left. 

 2 / W Moves the SHOULDER up and down. 

 3 / E Moves the ELBOW up and down. 

 4 / R Moves the wrist (PITCH) up and down.  
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 5 / T Rotates the wrist (ROLL) right and left. Can be 

configured for a peripheral axis. 

 6 / Y Opens and closes gripper via servo control. Can 

be configured for a peripheral axis. 

 7 / U Moves peripheral axis #7 (if connected).  

 8 / I Moves peripheral axis #8 (if connected). 

 

Figure ‎5-4: Manual Movement Dialog Box (XYZ) 

 

XYZ 

 

When XYZ is selected, clicking the buttons (or pressing the 

corresponding keys on the keyboard) moves the TCP, as 

described below. 

Movements in XYZ mode are sometimes a combination of 

simultaneous movements of a few axes. 

 Keys XYZ Motion 

 
1 / Q TCP moves along X-axis (back and forth). 

 
2 / W TCP moves along Y-axis (right and left). 

 
3 / E TCP moves along Z-axis (up and down). 

 
4 / R Axes move in order to change the gripper’s 

pitch angle; the TCP position does not change. 

 
5 / T The gripper rolls; the TCP position does not 

change. 

 

  

Open Gripper Completely opens the gripper.  

 

Close Gripper Completely closes the gripper. 
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The robot can be manipulated from the Manual Movement dialog box before it 

has been homed in Joint mode only. In fact, it is often necessary to bring the 

robot into a more suitable position before initiating the homing routine. 

However, an axis limit error message may appear during manipulation of a 

robot that has not been homed. 

Movement of an axis continues as long as the button or key is pressed, or until 

a software or hardware limit is reached. 
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Robot Movement Dialog Box 

The Robot Movement dialog box enables control over the robot in XYZ and 

Joint modes. 

 

Figure ‎5-5: ER 9Pro Robot Movement Dialog Box 

Clicking on an axis image or the XYZPR buttons moves the robot as described 

above at Manual Movement Dialog Box. 

To open the Robot Movement dialog box, select View | Robot Movement. 
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Teach Positions Dialog Box 

The Simple/Expanded Teach Positions dialog box enables the following: 

 Teaching positions (in Cartesian coordinates). 

 Recording positions (in Joint coordinates). 

 Sending the axes to the recorded positions (when program is not running). 

 Go to Position 

 Go Linear 

 Go Circular 

To display the description of the function of each icon in the Teach Position 

dialog box, simply place the mouse on the desired icon without clicking a 

mouse button.  

The user can define 5,000 positions. A higher computer (CPU and memory) 

can hold more positions.  

Simple (Level 1) 

 

Figure ‎5-6: Teach Positions Dialog Box (Simple), Level 1 

The Teach Positions (Simple) dialog box offers the following options: 

Position Number 1, 2 & Pro A numerical name for position. 

 

Record 1, 2 & Pro Records the current robot position (in joint coordinates) to the 

position displayed in the position number field.  

 

Delete  1, 2 & Pro Deletes from memory the position in the position number 

field. 

 

 

Go to 
Position 

1, 2 & Pro Executes the Go to Position command, which sends the 

robot’s TCP (Tool Center Point) from its current position to 

the selected position.  



SCORBASE  5-12 User Manual 

Position Definition  200030, Rev. D 

Speed 1, 2 & Pro Selects the speed for all movement commands as a percentage. 

 

Simple (Advanced Level) 

 

Figure ‎5-7: Teach Positions Dialog Box (Simple) for the Level 2 (Advanced) user. 

At the Advanced level, the Teach Positions dialog box offers all the commands 

available at Level 1, and also all of the following: 

Expand 2 & Pro Opens the Teach Positions (Expanded/Simple) 

dialog box.  

Absolute / 
Relative to 

2 & Pro Defines positions either as absolute or relative to 

another position. 

When Relative to is selected, a Relative to field 

appears. Select either an existing position or 

Current. A position that is Relative to Current 

means that the reference position is the robot 

position at the time it is sent to that position. 

Relative to is only available to Level 2 and Pro. 

Duration Pro Set movement duration in 1/10 second. 
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Expand (Advanced and Pro Levels) 

Click Expand to open the Teach Positions (Expanded) dialog box: 

 

Figure ‎5-8: Teach Positions (Expand) Dialog Box for Level 2 (Advanced) user 

X(mm), Y(mm) 
Z(mm), Pitch(deg), 

Roll(deg) 

Fields for displaying or changing the Cartesian 

coordinates of the selected position. (Pitch is not 

available for SCORA-ER 14Pro.) See the 

Cartesian Coordinate System (XYZ)section on 

page 5-3. 

Get Position Displays the Cartesian coordinates of the selected 

position. See the Cartesian Coordinate System 

(XYZ)section on page 5-3. 

Clear Clears all position coordinate fields. The position 

data does not change.  

Teach Teaches position using the Cartesian Coordinate 

System. 

 

 

Go Circular 

Executes the Go Circular to Position command. 

This command sends the robot in a circular path to 

the target position (in the position number field), 

via the position specified in the Via position field. 

The circular motion applies only to the robot. 

 

 

Via position Selects the intermediate position through which 

the Go Circular movement passes. 

 

 

Go Linear to  
Position 

Executes the Go Linear to Position command. 

Sends the axes in a straight line to the selected 

position. 

 

 

 

 

Simple Toggles to the Teach Position (Simple) dialog box.  
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Simple (Pro Level) 

 

Figure ‎5-9: Teach Positions (Simple) Dialog Box (Pro Level) 

At the Pro level, the Simple Teach Positions dialog box offers the following 

additional commands: 

Include Axes Pro Instructs the controller to define coordinates for 

axes for Robot, Peripheral or both. 

A peripheral position can be recorded only in the 

Pro level. 

Duration Pro Defines the time it takes to complete a movement 

command. The time is defined in tenths of a second.  

These commands remain available when the Teach Positions dialog box is 

expanded. 
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Recording Positions (Joint 
Coordinates) 



SCORBASE  5-16 User Manual 

Position Definition  200030, Rev. D 

Record Absolute Position  
(Levels 1, 2 & Pro) 

To record an absolute position: 

1. Use either the Manual Movement dialog box or the Robot Movement 

dialog box to move the robot to the position you want to record. 

2. Click on the Teach Position dialog box. 

3. Type a position number in the Position Number field, or select an 

existing position number if you want to modify (overwrite) a 

previously defined position. 

4. Select Absolute. 

5. Select Include Axes (Robot or Peripherals): 

a. Robot: to record a position for the robot axes. 

b. Peripherals: to record a position for the peripheral axes (Pro 

level only). 

c. The user can select both. 

6. To record the current position, click the Record Position icon.   

Record Relative Position (Pro Level) 

To record a relative position: 

1. Make sure you have first defined a reference position.  

2. Move the robot to the position whose coordinates you want to record 

as relative to another position. 

3. In the Position Number field in the Teach Positions (Simple) dialog 

box, enter a new position number. 

4. Select Relative to, and enter a number (or select Current) for the 

reference position in the Relative to field. 

5. Click on the Record icon. You have now recorded a relative 

position.  

A position that is Relative to Current means the specified offset will be 

computed from the location at which the robot is positioned at the time it is sent 

to the relative position. If the reference position changes, the relative position 

also moves. 
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Teaching Positions (XYZ Coordinates) 

In order to teach a position in Cartesian coordinates, click Expand.  

Teach Absolute XYZ Position (Levels 2 & Pro) 

To teach an absolute XYZ position 

1. Define a position number in the Position Number text box in the 

Teach Positions dialog box, or select one from the drop down menu. 

2. Click Expand. 

3. Enter XYZ, Pitch and Roll values. 

4. Click Teach.0.0. 

To use existing position coordinates to define a new position (or modify that 

position’s coordinates), do the following: 

1. In the Position Number field in the Teach Positions dialog box, 

select an absolute position number. 

2. Click Get Position. The XYZPR values of the position now appear 

in the XYZ, Pitch and Roll fields. Note: If the position is relative, 

only the offset values will be displayed. 

3. In the Position Number field, enter a different number (or leave the 

position number if you want to modify that position). 

4. To record a position for the robot axes, click Robot. 
To record a position for the peripheral axes, click Peripherals. 

To record positions for both, click Robot and Peripherals. 

5. In one or more of the coordinate fields, enter a new value (in 

millimeters or degrees). 

6. Click Teach. 0.0. 

Warning:  If you click on the  icon, the current TCP coordinates will 

be written to the selected position. 

Teach Relative XYZ Position (Levels 2 & Pro) 

To record a relative XYZ position: 

Make sure you have first recorded the reference position.  

1. In the Position Number field, in the Teach Positions dialog box, 

enter the new position number. 

2. Select Relative to, and enter the number of the reference position in 

the Relative to field.  

3. Click Clear to remove the current Cartesian coordiantes. 

4. In one or more of the coordinate fields, enter a new value (in 

millimeters or degrees). 
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5. Click Teach. 0.0. 

A position that is relative to current means the specified offset will be 

computed from wherever the robot is located at the time it is sent to the relative 

position. 

If the reference position changes, the relative position moves accordingly. 



User Manual  5-19 SCORBASE 

200030, Rev. D  Position Definition 

Positions Window 

Positions 

The Positions window displays a list of the positions of the currently open 

project. The list is presented in tabular format. As default, the table presents 

position information in Encoder counts, the Joint Coordinate System and the 

Cartesian Coordinate System. 

When fully open, the window is divided horizontally into two panels.  By 

dragging the bottom edge of the window, you can reveal the bottom panel.  The 

top panel displays all positions in the project (Position Inventory Panel).  The 

bottom panel (Watch Panel) displays the positions which have been selected 

for watching. 

 

Figure ‎5-10: Positions Window, fully opened to display both the Position Inventory Panel and the 

Watch Panel. 

Each row in the top portion of the table represents a single position. To 

manipulate the list: 

 Select a position (row). 

 Right-click to display the popup window. 

Position Popup Window 

 

Position No. Displays the number of the position. 

Delete Deletes the selected position. 



SCORBASE  5-20 User Manual 

Position Definition  200030, Rev. D 

Delete All Deletes all listed positions from the Position 

Inventory Panel and the Scorbase memory. 

Add Watch Copies the position data to the watch list, visible 

in the Watch Panel. 

Show Encoders Shows only Encoder counts of all positions.  

Show Joint Shows only Joint values of all positions. See the 

Joint Coordinate System section on page 5-2. 

Show XYZ Shows only the XYZPR of all positions. See the 

Cartesian Coordinate System (XYZ) section on 

page 5-3. 

Show All Show Encoders, Joint and Cartesian coordinates of 

all positions. 

Note: The peripheral positions are always displayed using encoder counts. 

Watch Popup Window 

 

Position No. Displays the number of the position. 

Remove Removes the selected position from the watch list, 

but does not affect its presence in the overall list. 

Remove All Removes all listed positions from the watch list, 

but does not affect their presence in the overall 

list. 

Show Encoders Shows only Encoder counts of all positions. 

Show Joint Shows only Joint values of all positions.  This can 

be set to a value different from the Position 

Inventory Panel. See the Joint Coordinate System 

section on page 5-2. 

Show XYZ Shows only the XYZPR of all positions. This can 

be set to a value different from the Position 

Inventory Panel. See the Cartesian Coordinate 

System (XYZ) section on page 5-3. 

Show Both Show Encoders, Joint and Cartesian coordinates of 

all positions. 
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Position Data Dialog Bars 

Scorbase offers three dialog bars that display all axes, encoder counts and the 

robot position in reference to both the Cartesian Coordinate System (XYZ) and 

the Joint Coordinate System. All dialog bars are accessible at all levels via the 

View menu.  They may also be opened or closed using the View | Show Both 
Dialog Bars or View | Close All Dialog Bars commands. 

Encoder Counts Dialog Bar 

The Encoder Counts dialog bar displays the current values of the encoders 

for each of the eight axes.  

 

Figure ‎5-11: Encoder Counts Dialog Bar 

To display the Encoder Counts dialog bar, select View | Dialog Bar | 
Encoders. 

The encoder values change whenever the axes are moved. 

These values are set to 0 (or close to zero) after the Search Home All Axes 

command is executed. 

XYZ Dialog Bar 

The XYZ dialog bar displays the current Cartesian Coordinate System (XYZ 

PR) values of the TCP. 

 

Figure ‎5-12: XYZ Dialog Bar 

To display the XYZ dialog bar, select View | Dialog Bar | XYZ.  

Joints Dialog Bar 

The Joints dialog bar displays the angles between the two links of the joint, in 

degrees. 

 

Figure ‎5-13: Joints Dialog Bar 

To display the Dialog bar, select View | Dialog Bar | Joints. 
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Using a Teach Pendant with Scorbase 

The Teach Pendant is a hand-held terminal that gives the operator direct control 

of the robot and peripheral axes. In addition to controlling movement of the 

axes, the Teach Pendant may be used for recording positions, sending the axes 

to recorded positions, and other functions. 

To control the axes from the Teach Pendant, Scorbase must be operating in the 

On-line mode, and the Teach/Manual switch on the Teach Pendant must be 

switched to Teach. This disables control of the axes from Scorbase dialog 

boxes. 

All Teach Pendant operations are reflected in the Scorbase dialog boxes. For 

example, positions recorded by the Teach Pendant will appear in the Positions 

list in the Teach Positions dialog box. 

The Teach Pendant operation is described fully in the Teach Pendant for 

Controller User Manual. 
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6  

Program Editing 

A Scorbase program is a set of instructions written by the user to control the 

robot, peripheral equipment and to communicate with external I/O devices. 

This chapter explains how to create and edit a Scorbase program. 

The following tools are used for program editing: 

 Program commands editor. 

 Command tree that lists all Scorbase commands. 
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Opening and Closing a Program  

Every Scorbase program is part of a Scorbase project. A project also includes 

the user-defined positions, project data and, if Robocell is installed, a virtual 

cell (3dc file). Only one project can be opened at a time. 

To open a saved program, open the project containing the desired program by 

doing one of the following: 

 Select File | Open Project…  

 Click on the Open an Existing Project icon. 

 Press Ctrl + O. 

In all cases, the Load Project window will open, prompting you to select the 

project that contains the program you want to edit.  

The program is displayed in the Program Window. 

To create a new project, do one of the following: 

 Select File | New Project…  

 Click on the Create a new project icon. 

 Press Ctrl + N. 

By default, the new project is opened with the Teach & Edit layout. This layout 

displays four windows: 

 Program Window that holds the Scorbase program. 

 Manual Movement Dialog Box. 

 Teach Positions Dialog Box. 

 Workspace Window that shows: 

 Project data, i.e., positions, user program and graphical display 

(if installed). 

 Scorbase Command Tree. 

The Program Window contains the text of the Scorbase program currently 

loaded.  Its title bar displays the name of the project.  Also shown by default is 

the programming toolbar. The toolbar contains a drop-down list of all 

subroutines available, for quick navigation. 

The Program window can be scrolled using the mouse wheel. 
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Figure ‎6-1: Program Window 

The Workspace Window contains two tabs to switch between the project files 

and the commands currently available. 

 

Figure ‎6-2: Workspace Window – Project Tab 

The Project tab displays the project and positions files pertaining to each 

project.  
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Figure ‎6-3: Workspace Window – Commands Tab 

The Commands tab displays the Command Tree, which in turn displays all of 

the commands available for the currently set Experience Level. 
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Program Editing Tools 

Scorbase is a text-based programming language in which every command is a 

single text line. Scorbase programs are edited by means of the usual Windows 

text editing options, which can be accessed: 

 Via the Edit menu 

 By pressing the designated keys 

 By right-clicking the mouse in the Program Window to open a pop-up 

menu. 
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Cut - 
Ctrl+X 

Deletes selected text or lines from the program, and places 

it on the Windows and Scorbase clipboards. 

Copy - 
Ctrl+C 

Places a copy of selected text or lines from the program on 

the Windows and Scorbase clipboard. 

Paste - 
Ctrl+V 

Inserts the contents of the Scorbase clipboard into the 

program. 

Find - 
Ctrl+F 

Opens a dialog box that allows you to search for any string, 

such as a command or text. 

 
Figure ‎6-4: Find Dialog Box 

Find Next - 
(F3) 

Repeats the last Find operation for the next occurrence. 

(Accessible also from the Find dialog window). 

Command/ 
Remark 

(*…) 

Inserts/deletes asterisk at beginning of a command line. 

Scorbase ignores command lines that start with an asterisk. 

This feature is useful for debugging. 

Go to Line Opens a dialog box that displays the total number of lines 

in the program and prompts you for a line number. Type in 

the number. The program editor will jump to the line you 

specify. 

 
Figure ‎6-5: Go To Line Dialog Box 
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Go to 
Selected 

Line 

Automatically scrolls the Program Window to display the 

line which you have selected.  This is useful for long 

programs when you have selected a particular line and then 

scrolled away from it.  In very short programs which fit 

within a single window, this function has no visible effect. 

 

In addition, use the keyboard for the following functions: 

[Ins] Toggles between Insert Mode and Overwrite 

Mode. The currently active mode is shown in the 

Status bar at the very bottom of the Scorbase 

window. 

In Insert Mode, a new command is inserted into 

the program above the line currently marked by 

the cursor. 

[Del] Deletes the line or lines currently marked by the 

cursor. 

[Ctrl+Home] Brings the cursor to the first line of the program. 

[Ctrl+End] Brings the cursor to the last line of the program. 

[PgUp] Displays the previous page of program lines. 

[PgDn] Displays the next page of program lines. 
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Adding and Editing Commands  

Scorbase commands are organized in a Command Tree, which is displayed in 

the Workspace Window.  Scorbase only displays the commands which are 

available in the currently set Experience Level.  

 At the Introductory level (Level 1), only basic commands appear in the 

Command Tree. 

 At the Advanced level (Level 2), the number of commands is increased. 

 At the Professional level (Pro Level), all commands are accessible. 

To see the Command Tree, click the Command tab in the Workspace Window.  

Scorbase commands are grouped into these categories: 

 Axis & Control 

 Program Flow 

 Inputs & Outputs 

 Advanced - By default, this category is hidden. Select Options | 
Advanced Options | Advanced Commands to display these 

commands.  

 Vision - By default, this category is hidden. Select Options | Advanced 
Options | ViewFlex Commands to display these commands.  

Clicking on a category opens/closes the list of commands. 

To add commands to a program, do one of the following: 

 Double-click on the desired command in the Command Tree. 

 Type the two letters written next to the command. 

 Click on the command icons in the Program Window (applicable only for 

selected commands).   

If you are working in Insert Mode, the new command line is added above the 

currently selected (highlighted) line. If you are working in Overwrite Mode, the 

new command replaces the selected line.  Toggle between the two modes using 

the [Ins] key. Many commands open dialog boxes for completing the 

command line parameters. 

To change a command parameter, click on the command to re-open the 

command dialog box. Change the required parameter, and click OK to close 

the dialog box.  
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Certain parameters are not accessible by the user at the Introductory (Level 1) 

and Advanced level (Level 2)  levels. At the Professional level (Pro Level), all 

parameters are accessible. 

To delete, cut, copy and paste a line, use the usual Windows tools. 
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Axis Control Commands 

 

 

 
Level 1 – Introductory Level 2 – Advanced Pro – Professional 

Figure ‎6-6: Command Tree - Axis Control 

Icon Command Levels Description 

 SH 

Search Home 

1,2,Pro Searches for the Home position of all of the robot’s and 

the peripherals’ axes. 

 

OG   

Open Gripper 

1,2,Pro Fully opens the gripper. 

 

CG   

Close Gripper 

1,2,Pro Fully closes the gripper (on itself, or on a grasped 

object). 
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GP   

Go to Position 

1,2,Pro Opens the Go to Position Dialog Box. The Go to 
Position command sends the robot to a recorded 

position, in the shortest time, using Point to Point (P to 

P) control. In Point to Point control, all axes move 

independently and there is no control over the TCP 

trajectory.  

 
Figure ‎6-7: Go To Position Dialog Box 

 

 

Movement Control 

Target 
Position 

The destination of the movement. Enter a 

number or a variable in this field.  

Speed/Duration 

Fast Executes the movement at the fastest 

speed possible.  

Speed Executes the movement at a slower speed. 

Defined as a percentage.  

Enter a number from 1 through 99. 

Default: 50 (average speed). 

Duration Executes the movement in a specific 

amount of time. Enter the time in tenths of 

a second, or a variable. Available only in 

Pro Level. 

Via 
Position 

The position via which the destination of 

the movement is reached. Enter a number 

or a variable in this field.  



SCORBASE  6-12 User Manual 

Program Editing  200030, Rev. D 

 

GL    

Go Linear to 
Position 

#_SpeedPercent ... 

2,Pro Sends the robot’s TCP (tool center point) from its 

current position to the target position, along a linear 

path (straight line). The linear motion applies only to 

the robot axes. Movement speed is defined as a 

percentage. 

 

GL    

Go Linear to 
Position 

#_SpeedMetric ... 

2,Pro Sends the robot’s TCP (tool center point) from its 

current position to the target position, along a linear 

path (straight line). The linear motion applies only to 

the robot axes. Movement speed is defined in mm/s. 

 
GC     

Go Circular to 
Position #_ 

Speed... 

2,Pro Sends the robot’s TCP in a circular path to the target 

position, via the position specified in the Via Position 

field.  The circular motion applies only to the robot. 

Note: The Circular command follows the circle defined 

by the three positions (current TCP position, target 

position, and the intermediate position specified in the 

Via position field). 

   Via Position The position via which the 

destination of the movement is 

reached. Enter a number or a 

variable in this field.  

 JA     

Jaw 

2,Pro Moves the gripper’s jaw to the specified span. The 

dialog box in Figure ‎6-8 is displayed. 

 
Figure ‎6-8: Jaw Dialog Box 

Enter a number or a variable in the Jaw field. 

Note: Accuracy cannot be guaranteed if the width is 

less than 5 mm or greater than 69 mm. 

Jaw activates Servo Control for the gripper motor, 

whereas Open Gripper and Close Gripper commands 

do not use the gripper axis Servo Control. 

Unless you need the Jaw command for a specific 

application, the Open Gripper and Close Gripper 
commands are recommended. 

Note: This command is not available for Pneumatic 
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Gripper. 

 IL     

If Home Switch < # 
> on jump to 

<Label> 

2,Pro The IL is a conditional jump command. It causes 

program execution to jump to the line that contains the 

specified Label, if the selected axis micro switch is 

pressed (On). The dialog box in Figure ‎6-9 is 

displayed. 

 
Figure ‎6-9: If Dialog Box 

Enter the Axis number or a variable in the Home 
Switch field.  

Enter the name of a Label in the Jump to field. 

 RP  

Record Position #_ 
 

Pro When the Record Position command is executed 

(during program execution), the controller records the 

current position data to the specified position. The 

dialog box in Figure ‎6-10 is displayed. 

 
Figure ‎6-10: Record Position Dialog Box 

Enter a position number or a variable in the Record 
Present Position as Position field.  

The Record Position command is useful when a 

position (and all relative positions that refer to that 

position) must be relocated, during program execution. 

This command updates the position data. 
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 SA    

 Set Axis #_ ... (to 
Zero) 

2,Pro Initializes (sets to 0) the encoder count of the selected 

peripherals axis. The dialog box in Figure ‎6-11 is 

displayed. 

 
Figure ‎6-11: Set Axis Dialog Box 

Enter a number or a variable in the Axis field. 

 SC  

Start Conveyor 
 

Pro Starts the conveyor, as a speed-controlled conveyor. 

Movement of the conveyor will continue until a Stop 
Conveyor (ST) command is encountered. 

The dialog box in Figure ‎6-12 is displayed. 

 

Figure ‎6-12: Start Conveyor Dialog Box 

 Enter the Axis number in the Axis field 

 Enter a number (as a percentage) or a variable in 

the Speed field.  

 Select a movement direction (Plus or Minus). 

Note: When operating a speed controlled conveyor by 

means of the Start/Stop Conveyor commands, do not 

record positions, and/or use the Set Axis (to Zero) 
command for the conveyor, in the same program. 

 ST  

Stop Conveyor 

Pro Stops the continuous motion of a conveyor that was 

initiated by a Start Conveyor (SC) command. 
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 SG  

Set Variable to 
Gripper Sensor 

Pro Assigns the value of the gripper opening (in mm) to a 

variable. This command is useful when there is a need 

to measure the object in the gripper, or to check the 

gripper status (open, closed or gripping an object). 

 

Figure ‎6-13: Set Variable (Gripper Sensor) Dialog Box 

In the Name field, enter the name of the variable. 

For more information on variables, see the Variable 

Programming section on page 7-1. 

Note: This command is not available for Pneumatic 

Gripper. 

 CN  

ControlOn 

 Enables all axes servo control by the controller. See 

the Control On / Control Off – CON/COFF section on 

page 4-8. 

 CF  

ControlOff 

 Disables all axes servo control by the controller. See 

the Control On / Control Off – CON/COFF section on 

page 4-8. 

 TJ  

Teach Position By 
Joints 

Pro Teaches the position as defined by the absolute 

positions of the joints. 
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Figure ‎6-14: Teach Position (Absolute Joints) Dialog Box 

Enter a new unique number in the Position Number 
box.  Enter the values for Base, Shoulder, Elbow, 

Pitch and Roll in 1/100ths of a degree. 

  Pro Get Position    Copies the values of the robot’s 

current position into the appropriate 

boxes. 

  Pro Clear               Clears the values from all the boxes. 

 

 RJ  

Teach Position By 
Joints Relative to 

Position 

Pro Teaches the position as defined by the positions of the 

joints relative to another defined position. (Pitch is not 

available for SCORA-ER 14Pro.) 

 

Figure ‎6-15: Teach Position (Relative Joints) Dialog Box 

Enter a new unique number in the Position Number 
box.  Enter the values for Base, Shoulder, Elbow, 

Pitch and Roll in 1/100ths of a degree, and choose 

which point this new one is to be calculated from. 
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 TX  

Teach Position by 
XYZ 

Pro Teaches the position as defined by the absolute 

Cartesian coordinate of the TCP (Tool Center Point). 

 

Figure ‎6-16: Teach Position (Absolute XYZ) Dialog Box 

Enter a new unique number in the Position Number 
box.  Enter the values for X, Y and Z in 1/100 mm, 

and Pitch and Roll in 1/100ths of a degree. 

 RX  

Teach Position by 
XYZ Relative to 

Position 

Pro Teaches the position as defined by the Cartesian 

coordinate of the TCP (Tool Center Point) relative to 

another defined position. (Pitch is not available for 

SCORA-ER 14Pro.) 

 

Figure ‎6-17: Teach Position (Relative XYZ) Dialog Box 

Enter a new unique number in the Position Number 
box.  Enter the values for X, Y and Z in 1/100 mm, 

and Pitch and Roll in 1/100ths of a degree. 
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 SJ  

Set Variable to 
Joint Position 

 Allows you to set a variable to the value of a specified 

joint at a specified position number. 

 

Figure ‎6-18: Set Variable to Joint Position Dialog Box 

Enter the name of the variable in the Variable Name 

field and select the position number from the Position 
Number drop-down list. Enter an integer between 1 

and 5 for the Joint number, as follows: 

Base 1 

Shoulder 2 

Elbow 3 

Pitch 4 

Roll 5 

 

You may also insert a variable which contains one of 

these values. 
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 SX  

Set Variable to 
Cartesian Position 

 Allows you to set a variable to the value of a specified 

Cartesian coordinate at a specified position number. 

 

Figure ‎6-19: Set Variable to CartesianPosition (Relative 

XYZ) Dialog Box 

Enter the name of the variable in the Variable Name 

field and select the position number from the Position 
Number drop-down list. Enter an integer between 1 

and 5 for the Cartesian coordinate number, as follows: 

X 1 

Y 2 

Z 3  

Pitch 4 

Roll 5 

You may also insert a variable which contains one of 

these values. 
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Program Flow Commands 

 

 

 

Level 1 – Introductory Level 2 – Advanced Pro – Professional 

Figure ‎6-20: Command Tree - Program Flow branch 

 

 

Icon Command Levels Description 

 WT     

Wait (10ths 
of second) 

1,2,Pro Halts program execution for a time specified in tenths of a second. 

The dialog box in Figure ‎6-21 is displayed. 

 

Figure ‎6-21: Wait Dialog Box 

Enter a number or a variable in the 1/10 of second field. 

 WC 2,Pro Halts program execution until a condition has been fulfilled. The 
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Wait For 
Condition 

dialog box in Figure 6-21 is displayed. 

 

Figure ‎6-22: Wait For Condition Dialog Box 

Enter a condition in the Logical Expression field, using the 

operators in the drop-down menu. 

 JU     

Jump to 
 

1,2,Pro This unconditional jump command causes the program pointer to 

jump to the line that contains the specified Label. The dialog box 

in Figure ‎6-23 is displayed. 

 
Figure ‎6-23: Jump To Dialog Box 

Enter the Label name in the Jump to field. (Be sure to include a 

line with this Label in your program.) 

When the Jump command is used, Jump is checked in the dialog 

box. You can modify the Jump command to an IF jump 

command (conditional jumping) only in Levels 2 and Pro. 
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 RE    
Remark 

2,Pro Allows insertion of a comment line for explanation and 

documentation into the program. The dialog box in Figure ‎6-24 is 

displayed. 

 

Figure ‎6-24: Remark Dialog Box 

Enter up to 47 characters of text, including spaces. 

 RB     

Ring Bell 

2,Pro When executed, this command produces a beep, using the 

computer’s internal loudspeaker. 

 RT  

Reset Timer 

Pro Scorbase uses a timer that measures time in units of tenths of a 

second. The timer starts operating when Scorbase is opened.  

The Reset Timer command resets the value of the Scorbase timer 

to 0. 

To use the timer, the timer value must be assigned to a variable, 

using the Set Variable command.  

 
SV     

Set Variable 
to 

Computation 

1,2,Pro Allows you to assign a value, or an expression (result of a specific 

computation), to a variable. 

The Set Variable dialog box is displayed (Computation is 

selected by default). 
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Figure ‎6-25: Set Variable (Default) Dialog Box 

In level 2, the Set Variable value can only be a result of 

computation. In the Pro level, variable values can be derived from 

other sources.  

Variable Name Enter the name of the variable. The first 

character must be a letter. 
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Value or 
Expression 

Enter a value or a formula. 

To set the variable to a fixed value, enter a 

number (in the range of +/-1000000). 

To set the variable to the result of a 

computation, enter a string that consists of 

two arguments and an operator. An 

argument can be either an integer or a 

variable (e.g., fun*2). 

You can use Visual Basic script variables 

and functions that are loaded. Append the 

prefix SCRIPT. to the beginning of the 

Visual Basic variable or function name. If 

more than one VB script is loaded, the 

programmer must ensure that there is no 

conflict of names. 

Click on the arrow to see a list of operators, 

or use the following list:  

Arithmetic Operators 

+ 
* 
- 
/ 
\ 

Addition 
Multiplication 
Subtraction 
Division 
Floating Point Division 

Algebraic Operators 

^ Power (raises the first argument to the 

power of the second argument). 

MOD Modulus (returns the remainder of the first 

argument divided by the second). 

Logical (Boolean) Operators 

NOT 
AND 
OR 

XOR 
EQV 
IMP 

Not 

And 

Or 

Exclusive or 

Equivalent (Null or Boolean values only) 

Implication  (Null or Boolean values only) 

The result of a logical operation is 1 (True), or 0 (False). Any 

operand with a non-zero value is considered true, while a zero 

value is considered false. 

 

 

Figure ‎6-26: Operators 

Drop-Down List, Set Variable 

Dialog Box 
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   A value assigned using the SV command can be used for 

conditional jumping using the IF <Condition> Jump command. 

Actions can then be generated according to the variable value. The 

following example jumps the program cursor to a label if more 

than three seconds elapse after timer reset: 

Reset Timer 

… 

Set Variable TIME to timer 

IF TIME > 30 jump to PICKUP 

For more information on variables, See the Variable Programming 

section on page 7-1. 

 VT    

Set Variable 
to Timer 

Pro Allows you to assign the current value of Scorbase timer to a 

variable. 

The Scorbase timer starts operating when Scorbase is opened. 

 

Figure ‎6-27: Set Variable Dialog Box (Timer)  

To initialize the Scorbase timer in a program, use the Reset 
Timer (RT) command. 
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IF     

If Jump to 

2,Pro A conditional branch command, which is used to determine 

the program flow in relation to the value of the variables. 

The dialog box in Figure ‎6-28 is displayed. 

 

Figure ‎6-28: If/Jump Dialog Box 

If the condition in the IF field is true, program execution 

jumps to the line specified by the label in the Jump to field. 

If the condition in the IF field is false, program execution 

skips to the following line. 

IF Enter the condition. The condition 

includes a variable name, a comparison 

operator and another variable name, or 

a number. 

Jump to Enter the name of a Label. (Be sure to 

include a line with this Label in your 

program.) 

   Example: 

If COUNTER > 0 jump to START_LOOP 

Go to Position 1 speed 5 

… 

START_LOOP: 

Go to Position 2 speed 5 

If the value of Counter is greater than zero, the robot will 

go to Position #1.  

If the value of Counter is equal to or less than zero, the 

robot will go to Position #2. 

Use two equal signs (= =) for equal operators. For example: 

If COUNTER == 0 jump to END 

The IF jump command can be converted to an 

unconditional jump command by selecting Jump (instead 

of If). 
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 SS     

Set 
Subroutine 

2,Pro Creates a subroutine. You can program up to 64 

subroutines in one program. The dialog box in Figure ‎6-29 

is displayed. 

 

Figure ‎6-29: Set Subroutine Dialog Box 

In the Name field, enter a name or number for the 

subroutine. 

Note: Create subroutines only at the end of the main 

program. Every subroutine must end with a Return from 
Subroutine command. 

 RS     

Return from 
Subroutine 

2,Pro Marks the end of a subroutine. At run time, this command 

terminates the execution of the subroutine, and the program 

resumes execution at the line that follows the Call 
Subroutine command. 

Note: Every subroutine must end with a Return from 
Subroutine command. 
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 CS    

Call 
Subroutine 

2,Pro Activates the specified subroutine. The dialog box in 

Figure ‎6-30 is displayed. 

 

Figure ‎6-30: Call Subroutine Dialog Box 

In the Name field, enter the name of the subroutine. 

Notes: Use the Call Subroutine command either from the 

main program or from another subroutine command. 

You can call the same subroutine repeatedly in the same 

program. 

You can call a subroutine from a Visual Basic script that is 

loaded. Append the prefix SCRIPT. to the beginning of the 

Visual Basic subroutine name. If more than one VB script is 

loaded, it is the responsibility of the programmer to ensure 

that there is no conflict of names. 

After the subroutine is executed, the program resumes 

execution from the line that follows the Call Subroutine 

command. 
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 RU      

Run 
Subroutine 

Pro Activates the selected subroutine. The dialog box in 

Figure ‎6-31 is displayed.  

 

Figure ‎6-31: Run Subroutine Dialog Box 

Either write a subroutine name, or select one from the drop 

down menu. To include the subroutine in the Scorbase 

program, press the Program button. To run the subroutine, 

press the Execute button. 

When the command is initiated, execution of the main 

program continues, and the subroutine runs concurrently. 

Scorbase facilitates the operation of up to 100 concurrent 

programs. (The Call subroutine command suspends the 

main program until the completion of the subroutine.) 

 LA     

Label 

1,2,Pro Marks a line in the program that is referenced by a Jump 

command. The dialog box in Figure ‎6-32 is displayed. 

 

Figure ‎6-32: Label Dialog Box 

In the Label field, enter a name.  

Do not include blank spaces – use an underscore. 

Do not use the same label name more than once. 

 PS     

Print to 
Screen & 

Log 

2,Pro Instructs Scorbase to print data containing strings, 

messages and variable values to a log file, or to the message 

window, or to both. The dialog box in Figure ‎6-33 is 

displayed. 
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Figure ‎6-33: Print Dialog Box 

Enter text and spaces of up to 47 characters. 

To print a value of a variable, place the variable name in 

single quote marks. For example: VARX='X' will print as 

VARX=50 (when the value of X is 50). 

Click the desired print destination. 
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 SM  

Send 
Message  

Pro Sends a message to MANAGER, Robot Device Driver, 

CNC Device Driver, or Device Driver. 

 

Figure ‎6-34: Send Message (Device) Dialog Box  

For a message to the MANAGER, select the type of 

message from the list of available types. Type a Task ID, 

and select a message from the drop-down menu. Consult 

the Open CIM user manual for more details. 

 

Figure ‎6-35: Send Message (Manager) Dialog Box 

For other device drivers, type the ID of the Device you 

wish to receive the message, and enter the string to be sent.   
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 MC  

Send 
Command 

Pro Sends a command to the CNC Device Driver.  This is the 

same dialog box as the SM command, except that the 

default device is the CNC Device Driver, and the default 

message is a command, rather than a string. 

 

Figure ‎6-36: Send Command (CNC Device) Dialog Box  

Enter the device ID and the command in the boxes. 

 LS  

Load Script 

Pro Loads a Visual Basic script by means of the following 

dialog box: 

 

Figure ‎6-37: Load Script Code Box 

The script must be located in the same subdirectory as the 

Scorbase project file.  You must be sure that the LS 

command is actually executed before you attempt to call 

any of the affected subroutines or variables. 

You may load more than one script into a single Scorbase 

project.  However, it is the programmer’s responsibility to 

ensure that there are no name conflicts. 

 EN  

End 
Program 

Pro This command simply enters the command End on the 

selected line of the program.  It signifies the end of the 

program.  It may be used in more than one subroutine, such 

as subroutines which respond to various error conditions. 
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Input/Output Commands 

 

 
Level 1 & 2 – Introductory & 

Advanced 
Pro – Professional 

Figure ‎6-38: Command Tree - Inputs & Outputs Branch  
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II     

If Input # 
On/Off Jump 

1,2,Pro Causes the program to jump to a label or call a subroutine, if 

the state of the tested digital input matches the status 

specified (On or Off). The dialog box in Figure ‎6-39 is 

displayed. 

 

Figure ‎6-39: If Input Dialog Box 

In the Input Number field, enter the number of digital input 

(1-8), or a variable. 

Select either On or Off for the state of the input. 

Select either Jump or Call Subroutine; then complete the 

active field. 

In the Jump to Label field, enter the name of a Label. 

In the Call Subroutine field, enter the name of a subroutine, 

or a variable. 

 OI     

On Input 
Interrupt # 

On/Off 

Pro Sets the condition for an input interrupt service. The service 

(Call Subroutine or Run Subroutine) will be performed 

whenever the condition (input status) is satisfied, regardless 

of the current program pointer position. The dialog box in 

Figure ‎6-40 is displayed. 

 

Figure ‎6-40: On Input Interrupt Dialog Box 
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Input Number Enter the number of a digital input, a 

variable or the word ANY. Use of the 

word ANY causes any input  

(1-8) to evoke the interrupt state. 

On/Off Select the state of the input. 

Call Subroutine Enter the name of a subroutine that will 

be executed in case of interrupt.  

Execution of the main program is 

suspended until completion of the 

subroutine. 

Run Subroutine Enter the name of a subroutine that will 

be executed in case of interrupt.  

Execution of the main program continues, 

and the subroutine is spawned as a 

concurrent process. 

An interrupt command causes the program to halt the command 

it is currently executing (which can also be a movement or a 

delay), and to immediately execute the command specified for 

this interrupt. If the specified command is a Call Subroutine, 

the program will resume from the point where it was 

suspended, as soon as the subroutine completes its execution.  

If the specified command is a Run Subroutine, the main 

program resumes immediately after the concurrent process is 

started. 
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An interrupt command can be disabled and enabled by means 

of the EI (Enable Interrupt) and DI (Disable Interrupt) 
commands described below. 

Example: 

 

Figure ‎6-41: On Input Interrupt (Call) Dialog Box 

This inserts the following line of code: 

On Input Interrupt 1 On Call Subroutine 

GET001 

When Input 1 is turned on, the program immediately calls 

subroutine GET001. If any axes are moving when the interrupt 

occurs, they will immediately stop. When the subroutine is 

completed (Return from Subroutine command is reached), the 

axes will reassume the position and status that were interrupted, 

and the program will continue from that point. 

 DI     

Disable 
Interrupt #  

 

Pro Causes the specified input interrupt to become inactive. When 

an interrupt is inactive, it is disregarded until the EI (Enable 
Interrupt) command reactivates it. The dialog box in 

Figure ‎6-42 is displayed. 

 

Figure ‎6-42: Disable Interrupt Dialog Box 

Input Number Enter an input number, a variable, or the 

word ALL. 

Enable/Disable Select Enable in order to modify the 

command. 
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 EI     

Enable 
Interrupt #  

 

Pro Causes the specified input interrupt to become active. The 

dialog box in Figure ‎6-43 is displayed. 

 

Figure ‎6-43: Enable Interrupt Dialog Box 

When an interrupt is active, it is waiting for an interrupt status 

(defined using the OI [On Interrupt] command described 

above). 

Input Number Enter an input number, a variable, or the 

word ALL. 

Enable/Disable Select Disable in order to modify the 

command. 

 

ON     

Turn On 
Output # 

1,2,

Pro 

Sets the state of the specified digital output On. The dialog box 

in Figure ‎6-44 is displayed. 

 

Figure ‎6-44: Turn On Output Dialog Box 

Output Number Select a number or type a variable name. 

The default settings of Digital and On can be changed. 
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OF     

Turn Off 
Output # 

1,2,

Pro 

Sets the state of the specified digital output Off. The dialog box 

in Figure ‎6-45 is displayed. 

 

Figure ‎6-45: Turn Off Output Dialog Box 

 

Output 
Number 

Select a number or type a variable name. 

The default settings of Digital and Off can be changed. 

 AO     

Set Analog 
Output # 

Pro Sets the state of the specified analog output. The dialog box 

in Figure ‎6-46 is displayed. 

 

Figure ‎6-46: Set Analog Output Dialog Box 

Output 
Number 

Enter a number (1 or 2), or a variable. 

Value Range Enter a number between 0 and 255 which 

corresponds to the output voltage. The 

range of the output voltage is 0-10 Volts.  

The Analog default setting can be changed. 
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 AI     

Set Variable to 
Analog Input # 

Pro Sets the value of the specified analog input to a variable. The 

dialog box in Figure ‎6-47 is displayed.  

 

Figure ‎6-47: Set Variable (Analog) Dialog Box 

Variable Name Enter the name of the variable. The first 

character of the name must be a letter. 

Analog Input 
Number 

Enter an input number (1-4) or a variable, 

where the variable value is an integer in 

the range of 0-255 corresponding to a 

controller input voltage of 0-10 volts. 

See also the description of the Set Variable commands in the 

preceding sections of this chapter.  

WN     

Wait For 
Digital Input 

# On 

2, Pro Causes the program to wait, if the state of the tested digital 

input is On. The dialog box in Figure 6-47 is displayed. 

 

Figure ‎6-48: Wait For Digital Input Dialog Box 

In the Input Number field, enter the number of digital input 

(1-16), or a variable. 
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WN     

Wait For 
Digital Input 

# Off 

2, Pro Causes the program to wait, if the state of the tested digital 

input is Off. The dialog box in Figure 6-48 is displayed. 

 

Figure ‎6-49: Wait For Digital Input Dialog Box 

In the Input Number field, enter the number of digital input 

(1-16), or a variable. 
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Advanced Commands 

Advanced Commands are displayed in the Command Tree when you select 

Options | Advanced Options | Advanced Commands. 

 

 
Pro – Professional 

Figure ‎6-50: Command Tree - Advanced Commands 

 

 UP     

Use Parameter 
Set 

Pro Specifies the Parameter Set to be used. The dialog 

box in Figure ‎6-51 is displayed.  

 

Figure ‎6-51: Use Parameter Set Dialog Box 

Open the drop-down list to select the desired 

Parameter Set and click OK. 

In program run-time the parameter set can be 

changed, and then returned to the default parameter 

set later in the program or the next time Scorbase is 

started.  

See the Parameter Set Window section on page 10-12 

for further information.  

See the Parameter Set Window on page 10-14 for 

further information.  
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 PV  

Set Parameter 
Value 

Pro Sets the value for a selected device parameter by 

name. The dialog box in Figure ‎6-52 is displayed.  

 

Figure ‎6-52: Set Parameter Value Dialog Box 

Axis Open the drop-down list to select the axis 

for which you need to change the parameter.    

Name Open the drop-down list to select the 

parameter whose value needs to be changed. 

Value Enter the new value. 

The details of the selected parameter are 

automatically displayed.   
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Vision Commands 

Vision Commands are displayed in the Command Tree when you select 

Options | Advanced Options | ViewFlex Commands. See the ViewFlex 

User Manual for full details. 

 

Pro – Professional 

Figure ‎6-53: Command Tree - Vision Commands 
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7  

Variable Programming 

The Scorbase language allows variable programming. Variables allow you to 

write commands that change as the state of the robot or its environment 

changes during program execution. Therefore they are useful for creating loops 

and subroutines in robot programs.  

To use a variable, it must first be defined using the Set Variable to 

Computation command. See the Program Editing section on page 6-1.  

Variable names can be up to 22 characters long. It is recommended, however, 

that you use meaningful names that are as short as possible. The first character 

of the name must be alphabetic. 

Scorbase has full access to variables in Visual Basic scripts that are loaded in 

memory.  The variable name must begin with SCRIPT., for example: 

SCRIPT.A. Values can be transferred both to and from variables in external 

Visual Basic scripts. 

In most editing commands, a variable can be specified instead of a numeric 

value.  

A variable cannot be used to specify a Label or a Subroutine. 

If, at run time, the program encounters a variable whose value is not defined or 

is out of range, an error message is displayed. 

 

Figure ‎7-1: Undefined Variable Error Message 
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Using a Variable Instead of a Numeric 
Value 

Example #1   

Set Variable station1=5 

Set Variable lamp=1 

Go to Position station1 fast 

Turn on output lamp 

In this example, one of the robot stations named “station1” is recorded as 

position #5 and a lamp is connected to output #1. When the program initiates, 

the value (5) is assigned to the variable named station1 and the value (1) is 

assigned to the variable lamp. The following program lines send the robot to 

position “station1” and turn on a “lamp”. Using a meaningful name for the 

variable makes the programming, debugging and maintenance easier. 

Example #2  

Set variable pos = 0 

Start: 

Set variable pos = pos +1  

Go to position pos fast 

Wait 50 (10ths of seconds) 

If pos < 5 jump to start 

In this example, the robot moves to Positions #1, #2, #3, #4 and #5. At each 

position, the robot waits 50 seconds. After waiting at position #5, the program 

terminates. 

Example #3  

Start: 

Set variable tested = 0 

Loop: 

Set variable tested = tested +1  

If input tested off call sub off 

If input tested on call sub on 

If tested < 8 jump to loop 

Jump to start 

 

Set Subroutine off 

Turn off output tested 

Return from subroutine. 

 

Set Subroutine on 
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Turn on output tested 

Return from subroutine 

In this example, the program sequentially scans digital inputs 1 through 8 in an 

endless loop. 

If the tested input is On, the program turns on the corresponding output. 

If the tested input is Off, the program turns the corresponding output off. 
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Monitoring Variable Value 

To monitor a variable value, Scorbase offers the following tools: 

1. When Scorbase is running and a Set Variable command is executed, 

the current value of the variable is displayed in the status line at the 

bottom of the screen. 

2. When the program is not running, click on the Set Variable 

command in which the value is assigned to the variable, and then 

execute this line using the Run Single Line command. The variable 

value is displayed in the status line at the bottom of the screen. 

3. The Print to Screen & Log (PS) command can also be used to print 

the actual value of a variable, by placing the variable name within 

single quote marks in the text to be printed.  

Example: 

Set Variable z = 5 

Set Variable x = 9 

Set Variable y = x - z 

Print to screen z=’z’ x=’x’ y=’y’ 

When the program is running, the following messages appear in the status bar: 

1. When the first line is executed, the message is z=5 

2. When the second line is executed, the message is x=9 

3. When the third line is executed, the message is y=4 

4. When the fourth line is executed, this window opens:  

 

Figure ‎7-2: Variable Status Dialog Window 
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8  

Program Execution 

The Program Window and the dialog bars described in this chapter are used for 

activating and monitoring program execution. 

Select Window | Run Screen to display only the Program window, which 

shows the section of the program currently executed. 
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Running a Program 

Scorbase offers three modes of running a program. To select the running mode 

do one of the following: 

 Click the appropriate Run icon in the toolbar.  

 Select one of the Run options in the Run Menu. 

 Press the function key. 

 

Single line (F6) Runs the currently selected (highlighted) line. 

 

Single cycle (F7) Runs the program from the currently selected 

(highlighted) line. Running stops after the last line 

is executed. 

 

Continuous (F8) Runs the program from the currently selected 

(highlighted) line. After the last line is executed, 

program execution continues from the first line. 

The [Run] key on the Teach pendant cannot be used to start execution of 

Scorbase programs. 

Note: Always restart execution of a program from the first line after you have 

changed program data (e.g., recorded new coordinates for a position, edited a 

program line, etc.). 
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Halting Program Execution 

Stop and Pause are the two methods of halting program execution from 

Scorbase. 

To stop or pause programs from Scorbase do one of the following: 

 Click the appropriate icon in the toolbar. 

 Select Run | Stop, or Run | Pause. 

 Press F9 / F10 - Make sure the Scorbase application is the currently active 

window before you press F9 (STOP) or F10 (PAUSE). 

 To STOP the program you can also press the red EMERGENCY button 

on the controller or press the ABORT key on the Teach Pendant (if 

installed). 

 

Stop (F9) Program execution is stopped immediately. Use 

this command only in emergencies. 

If the workstation is connected only to a stationary 

robot such as an ER 9Pro, the STOP command is 

sent directly to the device.  However, other 

devices such as the ER-400 AGV Mobile Robot 

require the user to define a subroutine with the 

name ON_STOP.  When the STOP button or F9 

is pushed, the ON_STOP subroutine is called. 

The subroutine might contain a line such as Turn 
Off Output 1.  Here is an example for use with 

the ER-400 AGV Mobile Robot: 

 

Figure ‎8-1: Program Window – ON_STOP 

subroutine. 

 

Pause (F10) Stops program execution only after the current 

command has been executed. Thus, axes may 

continue moving (to complete their motion) after 

the Pause command is issued. 
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Auto-run Subroutines 

There are three Auto-run subroutines in Scorbase. 

The first is the ON_STOP subroutine. See above for details. 

The second is the INITC subroutine. This subroutine runs automatically in the 

following three situations: 

1. When reloading a Scorebase project at the Scorbase application 

startup.  

2. When the Scorbase Open CIM device driver receives an initialization 

message from the CIM Manager. 

3. When the User manually selects either Standalone or On-line mode 

from the Scorbase Open CIM Screen.  

The last auto-run subroutine is AUTOEXEC. Call AUTOEXEC 

SUBROUTINE appears in the automatically generated script every time 

Scorbase receives the Pick and place or Place messages from the CIM 

Manager. 
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Inputs and Outputs Dialog Bars 

Digital Inputs & Outputs Dialog Bars 

The Digital Inputs & Outputs dialog bars show the status of the controller 

digital inputs and outputs. The display is available in all modes of operation. 

 

Figure ‎8-2: Digital Input Dialog Bar 

 

 

Figure ‎8-3: Digital Output Dialog Bar 

In both dialog bars, when the I/O status is Off (false), the matching I/O number 

is dark green. When the I/O status is On (true), the matching I/O number is 

light green  

If Scorbase in On-Line mode, the sixteen Output / Input LEDs on the front 

panel of the Controller indicate the I/O status. 

If Scorbase in On-Line mode, clicking on an output number in the Digital 

Output dialog bar toggles the status of the controller’s digital outputs. 

The Digital Input dialog bar can also be used to simulate the status of  the 

Controller's digital inputs. This option is useful for checking the If 

Input#_onJump command. 

Analog Inputs & Outputs Dialog Bars 

Scorbase can monitor and control four (4) analog inputs and two (2) analog 

outputs. The Analog Inputs & Outputs dialog bars show the values of the 

controller Analog Inputs and Outputs. These dialog bars may also be opened or 

closed using the View | Show All Dialog Bars or View | Close All Dialog 
Bars commands. 

 

Figure ‎8-4: Analog Input Dialog Bar 

 

Figure ‎8-5: Analog Output Dialog Bar 
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The Analog Inputs and Output resolution is 8-bit. The Analog Input / Output 

range is from 0 (minimum) to 255 (maximum). 

Output values can only be manipulated when Scorbase is operating On-line. To 

change the value of an Analog Output, do one of the following: 

 Click Output (the color turn from light yellow to white), and type a 

number. 

 Use the AO (Set Analog Output #) command, and run this line. 

When the controller receives an Analog Input signal from an external device, 

the value (0-255) of the signal is reflected in the Input Value field. 
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Scorbase Log File 

The Scorbase log file records the messages printed using the PS (Print to 
Screen Log) command. To print to a message to the log file, click either Log 
File or Screen and Log File. 

 

Figure ‎8-6: Print To Screen Command 

The Log file is initialized (cleared) each time Scorbase is loaded. 

To see the file content, open the file SCBS.LOG using a text editor (such as 

WordPad). The file is located in the Scorbase subdirectory named BIN.
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9  

Project Files Management 

A Scorbase project includes the following files: 

 Scorbase program (file extension *.SBP) 

 Recorded Position files (file extension *.PNT) 

 Project data (file extension *.WS) 

 Graphic image (if Robocell is installed – file extension *.3DC). 

Opening or saving a project from the File menu opens or saves all project files 

(three or four files).   

As default, all files are located in the Projects directory (folder) in the  

ER 9Pro or ER 14Pro directory (depending on which robot is being used for 

the project). 
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Project Management 

Scorbase project files are managed by means of the usual Windows file tools, 

which can be accessed by icons or via the File menu. Refer to Chapter 3 for 

details on the File Menu options.  
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10  

System Configuration 

Scorbase offers the following options for system configuration: 

 Window Layout options. 

 Experience level. 

 Hardware setup. 
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Window Layout Options 

Window Menu 

 

Figure ‎10-1: Window Menu 

The display options enable optimal usage of the screen area. Scorbase offers 

five basic display options and a wide range of dialog bars and windows 

through which the user can see and change system data. 
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Simulation & Teach  

 

Figure ‎10-2: Simulation and Teach Screen 

Available only if Robocell is installed.  This layout option displays the 

following windows: 

 Program Window that holds the Scorbase program. 

 3D Image 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Workspace Window that shows: 

 Project tab 

 Commands tab 

For further information, see the Robocell User Manual. 
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Teach & Edit 

 

Figure ‎10-3: Teach & Edit Screen 

When a Scorbase project is opened, the screen is set for the Teach & Edit 

display mode by default. In this mode, these windows and dialog boxes are 

displayed: 

 Program Window that holds the Scorbase program. 

 Manual Movement Dialog Box 

 Teach Positions Dialog Box 

 Workspace Window that shows: 

 Project tab 

 Commands tab 

To open the Teach & Edit layout, select Window | Teach & Edit. 
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Run Screen 

 

Figure ‎10-4: Run Screen 

The Run Screen display option opens only the Program Window. When the 

program is running, the currently executed line is highlighted and information 

on the currently executed command is displayed in the status bar. 

To open the Run Screen layout, select Window | Run Screen. 
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Project Screen 

 

Figure ‎10-5: Project Screen 

The Project Screen option displays the following: 

 Program Window that holds the Scorbase program. 

 Workspace Window that shows: 

 Project tab 

 Commands tab 

 Positions Window 

When the program is running, the currently executed line is highlighted, and 

information on the currently executed command is displayed in the status bar. 

To open the Project Screen layout, select Window | Project Screen. 
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Open CIM Screen 

 

Figure ‎10-6: Open CIM Screen 

The Open CIM Screen option displays the following: 

 Program Window that holds the Scorbase program. 

 Open CIM Device Driver Window, which provides: 

 Toolbar, with button for Manual Stop 

 Operation Mode selector 

 Online 

 Simulation 

 Standalone.  When this option is selected, you may press the  icon 

on the toolbar to open the TCP/IP dialog box for establishing 

communications with other Open CIM applications. 
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 Task History panel 

 Percentage Complete from Pick & Place File 

 CIM Messages panel 

 Messages Window 

 

To use the Open CIM Screen layout, select Window | Open CIM Screen. 

User Screen; Save User Screen 

 

Figure ‎10-7: Window Menu – Select User Screen 

By default, the User Screen displays the same windows as the Teach & Edit 

Screen.  However, the user can customize the layout of the windows to the 

needs of the project.  This is useful when you have specified one or more 

dialog bars under the View menu.  See the Dialog Bar Display Options section 

on page 10-18. 

To save the layout for future use, select Window | Save User Screen. Then 

save the project.  

Whenever you desire to use that layout again, select  Window | User Screen. 
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Other Options 

Options Menu 

Hardware Setup 

Scorbase allows you to define the devices that are connected and operated by 

the controller, depending on the Robot and gripper used, for a maximum of 

four axes. The following peripherals can be connected to the USB Controller: 

 

Figure ‎10-8: Options Menu – Hardware Setup 

 

Catalog 

number 

Description 

001009 Rotary Table, 

24V 

001010 Conveyor Belt 

(gray), 24V 

001013 Linear Table 

0.3m, 24V 

001014 XY-Table, 24V 

001016 1.0m Linear 

Slidebase, belt-

drive, 24V 
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001017 1.8m Linear 

Slidebase, belt-

drive, 24V 

001234 Motor Kit 

[127:7:1], 24V 

 

Note: Contact your local distributor for more information. 
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Do not change the hardware setup unless you are authorized to do so. To define 

the devices, select Options | Hardware Setup.  The Hardware Setup dialog 

box opens. Click on the arrow to open the list of available devices, and then 

click on the desired device. 

Figure ‎10-10: Hardware Setup Dialog Box 

(Initial) 

 

Figure ‎10-9: Hardware Setup Peripherals Dialog Box showing 

default settings 
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The Gripper Type section allows you to choose between a Servo gripper and a 

Pneumatic gripper. If Pneumatic is selected from the drop down menu, you 

must define the following:  

 The digital output to which the gripper is connected  

 The output state of the gripper 

 The duration of time after which Scorbase will continue to the next 

command 

When Pneumatic is selected, an Axis 6 drop down menu appears in the 

Peripherals section. This is because a Pneumatic gripper does not use an axis. 

You can therefore select an additional peripheral to be used on axis 6. 

 

Figure ‎10-11:Hardware Setup Gripper Type Dialog Box with Pneumatic Gripper Selected 

 

Figure ‎10-12: Hardware Setup Peripherals Dialog Box showing default settings for Axis 6. 

 



User Manual  10-13 SCORBASE 

200030, Rev. D  System Configuration 

The Hardware Setup option also enables you to work with a different robot 

from the one you selected during installation. To do so, click the Robot radio 

button. 

Figure ‎10-13: Hardware Setup Robot Dialog Box  

If SCORA-ER 14PRO is selected, an Axis 5 drop down menu appears in the 

Peripherals section. This is because the SCORA-ER 14Pro only has 4 Axes. 

You can therefore select an additional peripheral to be used on axis 5. 

In addition, a Warning Light section appears, which allows you to select 

which axis (1 -4) you want to assign to the warning light from the Connected to 

digital output #: drop down menu.  

 

Figure ‎10-14: Hardware Setup for SCORA-ER 14Pro 

Select the desired robot and click OK. 
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Parameter Set Window 

 

Figure ‎10-15: Parameter Set Window - for Robot 

 

 

Figure ‎10-16: Parameter Set Window - for Axes 
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Scorbase contains the following parameter sets: 

Parameter Set Description 

$3KG Parameter set for a 3Kg payload. 

$4KG Parameter set for a 4Kg payload. 

$Default Default set when parameters are optimized. 

Default payload is 2Kg. 

$Default is the default parameter set with a 2Kg payload that is loaded, even if 

an alternative parameter set was loaded in a previous session. It is at the user’s 

risk that a custom parameter is set, and Intelitek do not take responsibility for 

any damage that may occur as a result. 

To modify any of the parameters of the above vendor-supplied sets you must 

save the set under a different name. Click the Save As icon to open the dialog 

box. Enter the name of the new Parameter Set and click OK to save it. 

 

Figure ‎10-17: Parameter Set Window toolbar 

Use the Parameter Set Window toolbar to select one of the following options: 

 

Open Displays the Open Parameter Set window. Select 

the desired Parameter Set from the list. 

 

Save Saves the Parameter Set after changes have been 

effected. 

A Parameter Set marked with the $ symbol cannot 

be changed and saved. The set must first be saved 

under a new name using the Save As icon. 

 

Save As Opens the Save Parameters Set As dialog box. 

Enter the name of the new Parameter Set and click 

OK to save it. 

 

Default Displays the $Default Parameter Set. 

 

Apply Loads the selected Parameter Set to the controller. 

 

View Opens the selected Parameter Set Window, which 

lists all the parameter keys, with description and 

value, included in the Parameter Set. The keys are 

listed by sections.  
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Line Number 

 

Figure ‎10-18: Options Menu – Line Number Selection 

By default, Scorbase displays program line numbers in the Program Window. 

If you wish to hide them, uncheck the toggle under Options | Line Number. 

Reload Last Project at Startup 

 

Figure ‎10-19: Options Menu – Reload Last Project Selection 
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When Scorbase is initiated, the program can be set up to automatically open the 

last project. To toggle this option, select or deselect Options | Reload Last 
Project at Startup. A checkmark appearing next to this option indicates that 

the option is on. 

Experience Level 

Scorbase offers three experience levels: 

 Introductory (Level 1) 

 Advanced (Level 2) 

 Professional (Pro Level) 

A higher level offers more commands and tools. Levels can be selected from 

the Tool bar or from the Options menu. 

 

Level 1 Displays list of commands and options at 

introductory level. Commands related to Level 

2 and Pro are disabled. 

 

Level 2 Displays list of commands and options at 

advanced level. Commands related to Pro are 

disabled. 

 

Pro Displays list of all commands and options. 

Display of the Advanced Commands and the Vision Commands is activated by 

selecting Options | Advanced Options. 

View Menu 

The following display options are available from the View menu: 

 

Movement 
information 

Displays the following: 

 Position error for all eight axes 

 Home switch status (for all eight axes).  

 Index Pulses (for all eight pulses). The number 1 indicates the 

index pulse is not found at the current motor shaft position, while 0 

indicates the index pulse is found. Refer to the Hardware Setup to 

check which peripherals are attached. If a peripheral’s motor 

encoder has no index pulse, the axis’ value in the Movement 

Information dialog box will be “0”.  

  Selected axis (1 – 8) PWM value. The PWM value indicates the 

power sent to the axis motor.  
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Figure ‎10-20: Movement Information Dialog Box 

Messages Displays the content of the PS (Print To Screen) commands.  

 

Figure ‎10-21: Messages Window 

These two commands produce a window which overlaps the existing windows.  

The user should readjust the positions and sizes of these windows according to 

personal preference. 

Dialog Bar Display Options 

All Dialog bars are accessible from the View menu.  Select View | Dialog 
Bars. 

Joints Shows angle of the robot joints. See the Joints Dialog 

Bar section on page 5-21. 

XYZ Shows position coordinates of the TCP. See the XYZ 

Dialog Bar section on page 5-21. 

Digital output Shows digital output status and enables toggling an 

output status. See the Digital Inputs & Outputs 

Dialog Bars section on page 8-5. 

Digital input Shows the digital input status. Enables toggling an 

input status in Off-line mode, for program 

debugging. See the Digital Inputs & Outputs Dialog 

Bars section on page 8-5. 

Analog output Displays the value (0-255) of Analog output 1 and 2. 

These values can also be modified through this 

dialog bar. See the Inputs and Outputs Dialog Bars 

section on page 8-5. 

Analog input Displays the value (0-255) of Analog inputs 1-4. 



User Manual  10-19 SCORBASE 

200030, Rev. D  System Configuration 

Enables setting a value for an input in Off-line mode, 

for program debugging. See the Inputs and Outputs 

Dialog Bars section on page 8-5. 

Encoders Shows the values of the eight encoders. 

 

Each of these options adds a dialog bar to the bottom of the screen, overlapping 

whatever windows are displayed.  The user can retile the screen by reselecting 

the desired Window Layout Options from the Window menu. 
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11  

Sample Scorbase Projects 

The Scorbase package contains a number of sample projects that demonstrate 

some of the capabilities of Scorbase. These are accessible by selecting Open 

Project from the File menu, or clicking on the Open  icon in the toolbar. 

A list will appear of all of the *.WS files in the following subdirectory: 

C:\Intelitek\Scorbase-PRO\Projects\ER9ub (default directory location). 
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Project Descriptions 

AllMovements  

Demonstrates the use of various robot movement Scorbase commands and servo gripper operations.  

AGV_TEST  

Demonstrates Scorbase and Mobile Robot ER-400 interaction.  

ButtJoint  

Picks up a welding tool to weld two parts in a butt joint.  

ER9Cell1  

Builds two towers - one of cylinders and one of rectangular blocks. Demonstrates the use of numbered 

positions.  

ER9Cell2  

Builds two towers from parts supplied by the parts feeders. Demonstrates the use of named variables 

for positions.  

ER9Cell3  

Part sorting. Demonstrates the control of inputs and outputs. 

ER9Cell4  

Orders cylinders and process parts. Demonstrates complex PICK movements and program control 

using IF statements.  

ER9Cell5 and ER9Cell6  

Lathe and mill tending. Demonstrates complex operation involving a robotic arm mounted on a 

slidebase, two parts feeders, an Intelitek lathe, an Intelitek mill and various input/output functions.  

Excel_EX1  

Demonstrates the use of VBScript to transfer values from SCORBASE into Excel spreadsheets and 

build a chart.  
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Polygon  

Robot draw circle. Demonstrates the use of VBScript to transfer values from user input to 

SCORBASE and makes floating-point calculation available to SCORBASE.  

Script Demo  

Demonstrates the interaction between SCORBASE and VBScript, and the use of Microsoft Agent 

technology.  

Serial Port  

Demonstrates the use of VBScript to send text messages via a serial communications port.  

Tjoint  

Demonstrates complex pick & place movements and control of a welding tool, and the use of a corner 

jig to weld two parts in a T joint.  

ViewFlex  

Demonstrates Scorbase and ViewFlex (Intelitek Vision Software) interaction.  

RunProgram1  

Demonstrates Scorbase multitasking capability. 
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Appendix A 

Command Line Options 

The following table describes the command line options that enable the 

integration of user applications with Scorbase.  

Before operating Scorbase with these command line options, follow and obey 

all warnings and cautions provided in the user application manuals to prevent, 

for example, hazards from moving parts. 

The Scorbase command line format that is required when using the options 

described in the table is provided, as follows:   

Scorbase.EXE [Optional INI File] [Optional Switches] 

 

Option  Description 

/O Loads Scorbase in online mode.  

For example, Scorbase.EXE SCBS.INI /O  

/S Loads Scorbase in simulation mode. 

For example, Scorbase.EXE SCBS.INI /S 

/H Performs auto homing from online mode. 

For example, Scorbase.EXE SCBS.INI /H 

/L Loads a specific workspace in simulation mode.  

For example, Scorbase.EXE SCBS.INI /L=“C:\Program 

Files\Intelitek\SCORBASE-PRO\Projects\ER9ub” 

/R Loads a specific workspace and runs Scorbase.  

For example, C:\Intelitek\SCORBASE-

PRO\BIN\Scorbase.exe SCBS.INI 

/R=“C:\Intelitek\SCORBASE-

PRO\Projects\ER9ub\Er9Cell1.WS" 

/I Open CIM Robot Device Driver configuration file. 

For example: Scorbase.EXE /I=USBVD1.INI 

/N Open CIM Robot Device Driver number. 

/T Displays the Scorbase application on top of the desktop at 

all times. 
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Examples of Scorbase command line procedures are provided, as follows: 

Launch Scorbase and load the specified project in simulation mode: 

 In the system Run Window, type the following: 

C:\Intelitek\SCORBASE-PRO\BIN\Scorbase.exe /S 

/L=“C:\Intelitek\SCORBASE-PRO\Projects\ER9ub\Er9Cell1.WS”.   

Launch Scorbase in online mode, home all axes and load and run the specified 

Scorbase project:  

 In the system Run Window, type the following: 

C:\Intelitek\SCORBASE-PRO\BIN\Scorbase.exe /O /H /R 

=“C:\Intelitek\SCORBASE-PRO\Projects\ER9ub\Er9Cell1.WS”

/U Prevents the Scorbase application from staying on top of 

the desktop. This command can be activated only when 

Scorbase is open.   

/M Minimizes the Scorbase application. This command can be 

activated only when Scorbase is open. 

/E Restores the Scorbase application. This command can be 

activated only when Scorbase is open. 

/C Closes the Scorbase application. This command can be 

activated only when Scorbase is open. 

/CIMDD_ONLINE Open CIM-Scorbase device driver mode: Online 

/CIMDD_SIMUL_AUTO Open CIM-Scorbase device driver mode: Simulation 

/CIMDD_STANDALONE_ONLY Open CIM-Scorbase device driver mode: Standalone 
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Appendix B 

System Messages 

The robot has not been homed. 

The robot has not been homed. To home, either: 

 Select Run | Search home - all axes. 

OR 

 Click the Search Home  icon. 

Emergency button is pressed. 

The EMERGENCY button on the Teach Pendant is pressed, and control of the 

Robot has therefore been disabled. Release the button to regain control. 

Control is off. Do you want to execute Control ON? 

The controller must be in CON state for commands to be executed. Press OK 

to activate CON state or Cancel. 

Error: pneumatic gripper and warning light connected to the same digital output ‘n’ 

Assign either the pneumatic gripper or the warning light to another axis in the 

Hardware setup, so that there is no conflict. 

(5) The Movement Cannot be executed along the specified path! 

This message may occur for linear and circular movement types. 

 Check current robot position. 
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 If required, modify the coordinate values of the positions which define the 

trajectory. 

 (20) The Controller is not responding. 

 Make sure the controller is on. 

 Check the PC - USB-PRO controller cable connection. Select Options | 
On-line from the Menu bar. 

 Open Windows Device Manager, and check that Intelitek USB-PRO 

Robot Controller automatically pops up. 

(201) Position Error! The motion is too great or an impact has occurred. 

This error message can be displayed for the following reasons. 

 The robot has hit something 

 The speed is too high 

 An axis driver fuse has blown 

 There is a communication problem 

 There is an encoder fault 

 There is a mechanical fault 

 An axis is not connected. 

Determine and resolve the cause of the position error. Then re enable Servo 

control of the motors (CON), and try to repeat the last operated movement 

before the error message was displayed. 
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(202) Thermic Overload, Axis #. 

A thermic overload has occurred; all axes are disabled.  

The arm attempted to reach a position which could not be reached due to an 

obstacle (for example, a position defined as being above a table, but actually 

slightly below the table’s surface).  

The impact protection is not activated because the obstacle is close to the target 

position. However, integral feedback will increase the motor current and the 

motor will overheat, subsequently causing the Thermic Protection to be 

activated. 

 (533) Invalid parameter 

If the invalid parameter is from the default parameter set, reinstall Scorbase. 

(561) Time for homing has elapsed, axis # 

The homing process is taking too long. Possible causes are: 

 An invalid peripheral configuration for the axis. Check the hardware setup, 

which can be accessed by selecting Options | Hardware Setup from the 

Menu bar. 

 The home switch or index pulse was not found. 

 A hardware fault on the axis. 

 (563) Home switch not found, axis #. 

The home switch has not been found. Possible causes are: 

 An invalid peripheral configuration for the axis. Check the hardware setup, 

which can be accessed by selecting Options | Hardware Setup from the 

Menu bar. 

 A hardware fault on the axis. 

 (569) Homing aborted by user. 

The homing was aborted. To home, either: 

 Select Run | Search home - all axes. 
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OR 

 Click the Search Home  icon. 

(581) Invalid acceleration parameter. 

If the invalid parameter is from the default parameter set, reinstall Scorbase. 

 (582) Invalid parameter for acceleration increase! 

If the invalid parameter is from the default parameter set, reinstall Scorbase. 

 (583) Invalid velocity. 

Reduce the speed. 

 (586) Invalid Movement Duration 

The speed is equal to, or less than zero. Increase the speed. 

(610) Index pulse not found, axis #. 

There is a hardware fault on the axis. Try homing again. 

(612) Error: digital output ‘n’ assigned to pneumatic gripper 

Assign the peripheral to another axis. 

(613) Error: digital output ‘n’ assigned to warning light 

Assign the peripheral to another axis. 

(903) Control disabled! 

The Motors State Indicator should be off. This error message can be displayed 

for the following reasons. 
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 Control is off. 

 There is no controller communication. 

Activate servo control by clicking the Control On icon . 

(906) The position is not in the encoder workspace. 

A position has been set which is not in the encoder workspace. Replace the 

position with a suitable one. 

(907) The position is not in the joint workspace. 

A position has been set which is not in the joint workspace. Replace the 

position with a suitable one. 

(908) (935) (961)(962) (963) The position is not in the Cartesian  workspace. 

(This error message may be followed by one of the following: Kinematics; Alpha; Beta error) 

A position has been set which is not in the Cartesian workspace. Replace the 

position with a suitable one. 

 (909) Invalid time duration for the motion! 

The duration is too low and must be increased. 

(910) Invalid axis type. 

The user has tried to run an invalid command. For example, the Start stop 
conveyer command on a slidebase. 

(911) Motion in progress 

The user tried to run a new command whilst a previous command was still in 

progress. Wait until the previous command has been completed before 

attempting to run the next command. 
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(913) Excessive Speed 

The speed is too high; reduce the speed. 

(914) Excessive Acceleration 

The acceleration is too high; reduce the speed. 

(916) Relative chain loops or exceeds 255 positions! 

Two positions have been created relative to one another, creating a loop. 

(924) Invalid group! 

Linear or Circular setting has been applied for a peripheral. Linear and Circular 

Settings apply only to the robot. 

(925) Undefined position 

Record or teach the position. 

(930) The position is not in the peripheral workspace! 

A position has been set for a peripheral which is not in its workspace. Replace 

the position with a suitable one. 

(973) Peripherals positions are not suitable for peripherals configuration. 

The peripherals used in the project must match the peripherals defined in 

Hardware Setup. Either change the settings by selecting Options | 
Hardware Setup in the Menu toolbar, or save the project, and it will run 

irrespective of the peripheral configuration. 

This message will not appear in Robocell, when in Simulation mode. 


